Description
This manual is issued for reference only, at the convenience of Arbiter Systems. Reasonable effort was made to verify that all contents were accurate as of the time of publication. Check with Arbiter Systems at the address below for any revisions made since the original date of publication.

Contact Information
Arbiter Systems, Inc.
1324 Vendels Circle, Suite 121
Paso Robles, CA 93446
(805) 237-3831
Website: www.arbiter.com
mailto: techsupport@arbiter.com
mailto: sales@arbiter.com

Definition
This manual describes the Model 933A Portable Power Sentinel, Synchronized Power Quality Meter and PSCSV® software.

Firmware and Firmware Updates
This manual was created based on version 1.12 of the main DSP program, dated 18 February 2010. To display the firmware date, press DISPLAY > 9-Config & Status > the Version & S/N soft key.

Firmware Updates are available from Arbiter Systems website or by contacting technical support at the information above.
LIMITED WARRANTY

Arbiter Systems makes no warranty, expressed or implied, on any product manufactured or sold by Arbiter Systems except for the following limited warranty against defects in materials and workmanship on products manufactured by Arbiter Systems.

Products manufactured by Arbiter Systems are guaranteed against defective materials and workmanship under normal use and service for one year from the date of delivery. The responsibility of Arbiter Systems under this warranty is limited to repair or replacement, at Arbiter Systems’ option, of any product found to be defective. Arbiter Systems shall have no liability under this warranty unless it receives written notice of any claimed defect, within the earlier of:

- Thirty days of discovery by Buyer, or;
- One year from the date of delivery.

For warranty service or repair, products must be returned to a service facility designated by Arbiter Systems. Buyer shall prepay all shipping charges to Arbiter Systems, and Arbiter Systems shall pay shipping charges incurred in returning the product to Buyer. However, Buyer shall pay all shipping charges, duties and taxes for products returned to Buyer in a country other than the United States of America.

THE WARRANTY SET FORTH HEREIN CONSTITUTES THE ONLY WARRANTY OBLIGATIONS OF ARBITER SYSTEMS, EXPRESSED OR IMPLIED, STATUTORY, BY OPERATION OF LAW, OR OTHERWISE. ARBITER SYSTEMS DISCLAIMS ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, AND BUYER EXPRESSLY WAIVES ALL OTHER WARRANTIES.

This limited warranty does not extend to any product, which has been subject to

I Improper use or application, abuse, or operation beyond its rated capacity, or contrary to the instructions in the operation and maintenance manuals (if any);

II Accident;

III Repair or maintenance performed by Buyer, except in accordance with the operation and maintenance manuals, if any, and any special instructions of Arbiter Systems;

iii
IV Modification without the prior written authorization of Arbiter Systems (whether by the substitution of non-approved parts or otherwise).

The remedies provided herein are Buyer’s sole and exclusive remedies. In no event shall Arbiter Systems be liable for direct, indirect, incidental or consequential damages (including loss of profits), whether based on contract, tort, or other legal theory.

FOR THE FASTEST POSSIBLE SERVICE, PLEASE PROCEED AS FOLLOWS:

1. Notify Arbiter Systems, Inc., specifying the instrument model number and serial number and giving full details of the difficulty. Service data or instrument-return authorization will be provided upon receipt of this information.

2. If instrument return is authorized, forward prepaid to the manufacturer. If it is determined that the instrument is not covered by this warranty, an estimate will be made before the repair work begins, if requested.

See Contact Information on page ii.
# Contents

1 **Introducing the Model 933A**  \hspace{1cm} 1  
   1.1 Scope \hspace{1cm} 1  
   1.2 Included Accessories \hspace{1cm} 2  
   1.3 933A Features \hspace{1cm} 3  
      1.3.1 Features and Accessories \hspace{1cm} 3  
   1.4 Available Accessories \hspace{1cm} 4  
      1.4.1 Lead Set Information \hspace{1cm} 4  
      1.4.2 Three-Phase Voltage Lead Set, 813AT \hspace{1cm} 5  
      1.4.3 Three-Phase Voltage Lead Set, 813BT \hspace{1cm} 5  
      1.4.4 3-Phase Spade Lug, Current Lead Set, 816AT \hspace{1cm} 6  
      1.4.5 3-Phase Spade Lug, Current Lead Set, 916CT \hspace{1cm} 6  
      1.4.6 Universal Test Plug Current Lead Set, 811AT \hspace{1cm} 7  
      1.4.7 Universal Test Plug Current Lead Set, 811CT \hspace{1cm} 7  
      1.4.8 Universal Test Plug Current Shunt \hspace{1cm} 7  
      1.4.9 Adjustable Bail \hspace{1cm} 8  
      1.4.10 400 Amp, 20:1 Precision CT \hspace{1cm} 8  
      1.4.11 Clamp-on Current Probes for the 933A \hspace{1cm} 9  
      1.4.12 Low Current Modules \hspace{1cm} 9  
      1.4.13 GPS Antenna Module \hspace{1cm} 10  
      1.4.14 Auxiliary I/O Module \hspace{1cm} 11  
   1.5 Safety Information \hspace{1cm} 12  
      1.5.1 Definitions \hspace{1cm} 12  
      1.5.2 Terminology \hspace{1cm} 12  
      1.5.3 Warnings \hspace{1cm} 12  

2 **Basic Operation**  \hspace{1cm} 14  
   2.1 Introduction \hspace{1cm} 14  
   2.2 Powering the Model 933A \hspace{1cm} 14  
      2.2.1 Operation with the AC Power Cord \hspace{1cm} 14  
      2.2.2 Operation with Battery Power \hspace{1cm} 15
2.2.3 Charging the Internal Battery .......................... 15
2.3 Controls and Connections ................................. 16
  2.3.1 Inputs and Interface ................................. 18
  2.3.2 Front Panel Connectors ................................. 18
  2.3.3 Chassis Ground ....................................... 18
  2.3.4 Voltage Inputs, 650 Vrms ............................... 19
  2.3.5 Current Input Module, 20 Arms (933A-01) ............... 19
  2.3.6 Synchronizing the 933A ............................... 20
  2.3.7 GPS Timing Signals .................................. 20
  2.3.8 IRIG-B Timing Signals ................................ 21
  2.3.9 Communication Ports .................................. 21
  2.3.10 Auxiliary I/O Port .................................. 22
  2.3.11 IEC-320 Power Inlet Connector ......................... 22
2.4 Function Keys & Indicators .............................. 23
  2.4.1 On/Off Key .......................................... 23
  2.4.2 Display Selection Key ................................ 23
  2.4.3 Setup — Configuring the 933A ......................... 24
  2.4.4 Five Soft Keys ....................................... 24
  2.4.5 Display Lighting Key .................................. 25
  2.4.6 Cursor Keypad / Enter Key ......................... 25
  2.4.7 Numeric Keypad ....................................... 26
  2.4.8 Log Key .............................................. 26
  2.4.9 Review Key .......................................... 26
  2.4.10 Print Key ........................................... 26
  2.4.11 Hold Key ........................................... 27
  2.4.12 933A Status Indicators .............................. 27
2.5 PSCSV Software ........................................ 29
  2.5.1 USB or RS-232C ...................................... 29
  2.5.2 Connecting ........................................... 29
  2.5.3 Configuring .......................................... 30
  2.5.4 Downloading Data .................................... 30
2.6 Bitmapped File Downloading .............................. 30
  2.6.1 Tera Term Pro BMP File Transfer ...................... 31
  2.6.2 HyperTerminal BMP File Transfer ...................... 32

3 The Setup Menu ............................................. 33
  3.1 Setup Key .............................................. 33
  3.2 Input Setup Menu ....................................... 34
    3.2.1 Selecting the System Input .......................... 34
  3.3 Clock Time Set ......................................... 36
    3.3.1 Internal Real-Time Clock ............................ 36
    3.3.2 Clock Setup in Free-Running Mode ................... 37
3.3.3 Clock Setup in Synchronized Mode ............ 38
3.4 Serial Setup .................................. 39
  3.4.1 Setting up the RS-232 port .............. 39
3.5 Autolog Setup ................................ 40
  3.5.1 Logging Data Indication ............... 41
3.6 CT/PT Setup .................................. 42
3.7 Custom DST Setup ............................ 43
3.8 Current Setup ................................ 44
3.9 Using Optional Low Current Modules ..... 45
  3.9.1 Installing ............................... 45
  3.9.2 Configuring ............................ 46
3.10 Trigger Setup ................................ 46

4 The Display Menu 47
  4.1 Display Selection ............................ 47
  4.2 Min–Max Setup ................................ 48
  4.3 Tabular Results ............................... 49
  4.4 Harmonic Results ............................ 50
    4.4.1 Graphical Harmonics ...................... 50
    4.4.2 Tabular Harmonics ....................... 50
  4.5 Waveform Display ............................ 51
    4.5.1 Magnify Waveforms ....................... 52
  4.6 V & I Tabulation ............................. 52
    4.6.1 Show Sequence ........................... 53
    4.6.2 Show Ratio ............................... 53
    4.6.3 Show Impedance .......................... 53
  4.7 Power Tabulation .............................. 54
    4.7.1 Power Calculations ....................... 54
  4.8 Power Quality ................................. 55
    4.8.1 Min–Max .................................. 55
    4.8.2 Flicker Information ...................... 56
  4.9 Energy Tabulation ............................. 57
  4.10 Phasor Display ............................... 58
  4.11 Basic Data List .............................. 59
  4.12 Config & Status ............................. 60
    4.12.1 Status with GPS Synchronization ....... 61

5 Reviewing 933A Data 62
  5.1 Review Data Selections ....................... 62
    5.1.1 Show Log Data ............................ 63
    5.1.2 Show User Event Records ............... 63
    5.1.3 Show Power Quality Event Records ....... 63
5.1.4 Erase Log Data .............................................. 63
5.2 Steps to Locate & Review Records .......................... 63
  5.2.1 Locating the Data Logged During an Event .......... 63
  5.2.2 Locating Event Records .......................... 64
  5.2.3 Reviewing Recorded Data (Show Log) ............. 64
  5.2.4 Review Selections Soft Key ......................... 66
5.3 Reviewing User Event Records ............................... 67
  5.3.1 Interpreting a User Event Record .................. 67
  5.3.2 Searching for Records .......................... 68
  5.3.3 Viewing Waveform Data at Time of Event .......... 69
5.4 Reviewing Power Quality Event Data ....................... 70
  5.4.1 Viewing 1-Second Data Records .................... 70
5.5 Reviewing Data using PSCSV ............................... 71
  5.5.1 User Event Record Example ......................... 72
  5.5.2 Per Second Data .................................. 73
  5.5.3 Power Quality Event Record Example .............. 74
  5.5.4 Waveform Data .................................. 75

6 PSCSV Basics .................................................. 77
  6.1 Introduction .............................................. 77
    6.1.1 PSCSV Features .................................. 77
    6.1.2 Linking ............................................. 77
  6.2 Windows, Menus and Toolbars ............................. 78
    6.2.1 Main Window ........................................ 78
    6.2.2 Menu Definitions .................................. 79
    6.2.3 Toolbar and Button Definitions .................... 81
    6.2.4 Connecting with the 933A ......................... 84
    6.2.5 Configuring the 933A .......................... 85
    6.2.6 Configuring Measurement Parameters .............. 88
    6.2.7 Other Windows ..................................... 89
  6.3 Broadcast Data ............................................ 91
    6.3.1 Basic Data .......................................... 91
    6.3.2 Energy Data ......................................... 92
    6.3.3 Harmonic Data ...................................... 93
    6.3.4 Harmonic Summary Data .......................... 94
    6.3.5 Waveform Data .................................... 95
    6.3.6 Phasor Data ........................................ 96
    6.3.7 Lists of Broadcast Values ......................... 97
  6.4 Data Conversions ........................................... 98
    6.4.1 Exporting COMTRADE Files ......................... 98
    6.4.2 Exporting to CSV Format .......................... 99
    6.4.3 Exporting to PQDIF Format ...................... 100
# 9 Functional Description

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>9.1</td>
<td>Scope</td>
<td>129</td>
</tr>
<tr>
<td>9.2</td>
<td>Overview</td>
<td>129</td>
</tr>
<tr>
<td>9.3</td>
<td>Clock Synchronization</td>
<td>130</td>
</tr>
<tr>
<td>9.4</td>
<td>Current Inputs</td>
<td>130</td>
</tr>
<tr>
<td>9.5</td>
<td>Voltage Inputs</td>
<td>130</td>
</tr>
<tr>
<td>9.6</td>
<td>Error Analysis</td>
<td>131</td>
</tr>
<tr>
<td>9.7</td>
<td>Signal Sampling</td>
<td>132</td>
</tr>
<tr>
<td>9.8</td>
<td>Power and Energy</td>
<td>132</td>
</tr>
<tr>
<td>9.9</td>
<td>Voltage and Current</td>
<td>133</td>
</tr>
<tr>
<td>9.10</td>
<td>CT and PT Compensation</td>
<td>133</td>
</tr>
<tr>
<td>9.11</td>
<td>Transformer Compensation</td>
<td>134</td>
</tr>
<tr>
<td>9.12</td>
<td>DC Offsets</td>
<td>134</td>
</tr>
<tr>
<td>9.13</td>
<td>Phase and Frequency</td>
<td>135</td>
</tr>
<tr>
<td>9.14</td>
<td>Harmonics</td>
<td>136</td>
</tr>
<tr>
<td>9.15</td>
<td>Flicker</td>
<td>137</td>
</tr>
<tr>
<td>9.16</td>
<td>Interruptions</td>
<td>137</td>
</tr>
<tr>
<td>9.17</td>
<td>Voltage Fluctuations</td>
<td>138</td>
</tr>
<tr>
<td>9.18</td>
<td>System Time Deviation</td>
<td>138</td>
</tr>
<tr>
<td>9.19</td>
<td>Phasor Measurements</td>
<td>138</td>
</tr>
<tr>
<td>9.20</td>
<td>Phase Balance</td>
<td>138</td>
</tr>
<tr>
<td>9.21</td>
<td>Load Balance</td>
<td>139</td>
</tr>
<tr>
<td>9.22</td>
<td>Flash Memory and Event Logging</td>
<td>139</td>
</tr>
<tr>
<td>9.23</td>
<td>Optional Contacts &amp; Event Inputs</td>
<td>140</td>
</tr>
<tr>
<td>9.24</td>
<td>Serial Channels</td>
<td>141</td>
</tr>
<tr>
<td>9.25</td>
<td>Triggering in the Model 933A</td>
<td>141</td>
</tr>
<tr>
<td>9.26</td>
<td>Detecting Oscillatory Transients and Other Anomalies</td>
<td>142</td>
</tr>
</tbody>
</table>

# 10 Connection Diagrams

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>10.1</td>
<td>1P2W1E – Direct Connection</td>
<td>146</td>
</tr>
<tr>
<td>10.2</td>
<td>1P2W1.5E – Direct Connection</td>
<td>147</td>
</tr>
<tr>
<td>10.3</td>
<td>1P3W2E – Direct Connection</td>
<td>148</td>
</tr>
<tr>
<td>10.4</td>
<td>3P3W2E Delta – Direct Connection</td>
<td>149</td>
</tr>
<tr>
<td>10.5</td>
<td>3P4W2.5E – Direct Connection</td>
<td>150</td>
</tr>
<tr>
<td>10.6</td>
<td>3P4W3E – Direct Connection</td>
<td>151</td>
</tr>
<tr>
<td>10.7</td>
<td>1P2W1E – Using CT/PT</td>
<td>152</td>
</tr>
<tr>
<td>10.8</td>
<td>1P2W1.5E – Using CT/PT</td>
<td>153</td>
</tr>
<tr>
<td>10.9</td>
<td>1P3W2E – Using CT/PT</td>
<td>154</td>
</tr>
<tr>
<td>10.10</td>
<td>3P3W2E – Using CT/PT</td>
<td>155</td>
</tr>
<tr>
<td>10.11</td>
<td>3P4W2.5E – Using CT/PT</td>
<td>156</td>
</tr>
<tr>
<td>10.12</td>
<td>3P4W3E – Using CT/PT</td>
<td>157</td>
</tr>
</tbody>
</table>
List of Figures

1.1 933A with Accessories ........................................... 2
1.2 813AT Voltage Lead Set ........................................... 5
1.3 816AT Current Lead Set ......................................... 6
1.4 811AT Current Lead Set ......................................... 7
1.5 933A Case Bail Assembly ......................................... 8
1.6 933A-02/03 Low Current Modules .............................. 9
1.7 GPS Antenna Module and Cable Assembly ..................... 10
1.8 External I/O and Cable Assembly ............................... 11
2.1 Battery and Flash Status Screen ............................... 16
2.2 Front Panel Description ........................................ 17
2.3 Voltage and Current Inputs .................................... 19
2.4 Display Key Menus ............................................... 23
2.5 Setup Key Menus ................................................ 24
2.6 Five Soft Keys .................................................... 24
2.7 Brightness/Contrast Control .................................... 25
2.8 Numeric and Cursor Keypads .................................... 25
2.9 Status Indicator Definitions .................................... 27
3.1 Setup Key Display ............................................... 33
3.2 Input Setup Menu ............................................... 34
3.3 Custom Input Configuration .................................... 35
3.4 Clock Setup ...................................................... 36
3.5 RS-232 Setup ..................................................... 39
3.6 Autolog Setup .................................................... 40
3.7 Review Log Data ................................................ 41
3.8 CT/PT Setup Menu ............................................... 42
3.9 Custom DST Setup Menu ........................................ 43
3.10 Current Setup Menu ............................................. 44
3.11 Low Current Module Setup Menus ............................ 45
3.12 Trigger Review Menu ............................................ 46
# List of Tables

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>9.1</td>
<td>Power/Energy Error Analysis</td>
<td>131</td>
</tr>
<tr>
<td>9.2</td>
<td>Signal Functions Available for Triggering</td>
<td>143</td>
</tr>
<tr>
<td>9.3</td>
<td>Trigger Channel Parameter Summary (32 Channel)</td>
<td>144</td>
</tr>
<tr>
<td>9.4</td>
<td>Schulz-Laios Transient Detector Algorithm Control (6 Channel) [1]</td>
<td>144</td>
</tr>
</tbody>
</table>
Chapter 1

Introducing the Model 933A

1.1 Scope

The Model 933A Portable Power Sentinel is designed to provide highly-accurate measurement of electrical power quality and many other electrical values important to the power industry. A true seven-channel instrument, the Model 933A allows independent measurement of three-phase currents and voltages (including neutral), and associated values.

Designed for data recording and storage, memory is divided between two 128-MB flash cards. One memory card receives data at the highest sampling rate directly from the DSP for waveform data storage, and the other memory card stores the more accurate, standard data after processing.

To enhance portable operation, the Model 933A has an internal Nickel Metal Hydride (NiMH) battery. It also has a standard IEC-320 line power inlet for normal operation and for battery charging.

While the 933A was designed to operate independently in portable situations from the front panel, its capability is enhanced through using Power Sentinel CSV 933™ software. Hereafter, the application software is referred to as “PSCSV”.

1
1.2 Included Accessories

<table>
<thead>
<tr>
<th>Accessory</th>
<th>Ordering Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>CT Input Module</td>
<td>AS0074100</td>
</tr>
<tr>
<td>Country specific AC power cord</td>
<td>P01R – P12R</td>
</tr>
<tr>
<td>Safety ground lead with clip</td>
<td>812H</td>
</tr>
<tr>
<td>Modular DB-9 to RJ-11 adapter</td>
<td>AP0007700</td>
</tr>
<tr>
<td>Operation Manual</td>
<td>AS0093900</td>
</tr>
</tbody>
</table>

Figure 1.1: 933A with Accessories
1.3 933A Features

Listed below are some of the most obvious and significant features of the Model 933A, Portable Power Sentinel. While many of the most significant features of the 1133A Power Sentinel are present, the 933A embodies some additional features that make it uniquely important as a synchronized power measurement device.

1.3.1 Features and Accessories

- Seven-Channel Measurement, including three voltage, three currents plus neutral current.
- Separate tabular and graphical indications of each measurement channel, including voltage, current, power values, power factor and frequency. Includes Min/Max values and Average.
- Harmonic Measurement out to the 50th harmonic in both graphical and tabular format.
- Waveform analysis, including high-speed waveform capture
- Sophisticated Triggering from the DSP and external signals
- Power quality, energy, phasor, combined measurement viewing
- Optional current modules for low range, seven-channel measurement
- Auxiliary I/O Module for timing external events and controlling relay contacts
- GPS module for synchronized measurement
- Two separate 128 MB flash memory cards for storing regular data and high-speed waveform data
- Dual inlet power, including wide range AC/DC supply and rechargeable Nickel Metal Hydride battery
- PSCSV Application software to configure the 933A and control measurement; use either the RS-232 or USB interface.
1.4 Available Accessories

- Current and Voltage Lead Sets
- Adjustable Bail Assembly
- 400 Amp Direct Current Transformer
- 100 Amp Clamp-on CT, current output
- 100 Amp Clamp-on CT, voltage output
- Low Current Modules
- GPS Antenna Module
- Auxiliary I/O Module

1.4.1 Lead Set Information

Arbiter Systems offers test lead wire with your choice of two insulation types, Santoprene and silicone. Both silicone and Santoprene insulated lead wires are made using finely-stranded rope-lay copper conductors for exceptional flexibility and limpness.

Silicone is our premier test lead wire. Highly flexible over a wider range of temperatures (-70 to +150° C, -100 to +300° F) than any other flexible insulation material, with excellent resistance to damage due to flame and heat, our silicone wire is highly recommended where safe operation is required with the possibility of high-current through faults. Silicone is nonflammable, and will not emit toxic or irritating fumes at extreme temperatures or under overload conditions.

For most applications, our Santoprene insulated test lead wire is a cost-effective alternative to silicone, offering most of the same advantages at a price which compares favorably with PVC, neoprene, and other lower-quality insulations. Because Santoprene is a thermoplastic rubber, however, it will melt at a temperature of +216° C (+421° F), and it is primarily recommended for use in applications where high-current faults are less likely. Santoprene offers excellent resistance to arc ignition and good resistance to ignition by a hot wire. And, unlike PVC or halogenated rubber compounds, Santoprene does not emit toxic and irritating fumes when it is overheated or burned, and it is inherently self-extinguishing.
1.4.2 Three-Phase Voltage Lead Set, 813AT

The 813AT is a three-phase, four-wire lead set that provides safety-shrouded stackable 4-mm banana plugs on both ends of the lead set; includes various plug-on accessories compatible with the 4-mm banana plugs. This lead set is assembled with #16 Santoprene-insulated lead wire; leads are protected by gray PET armor and include a Velcro lead strap.

Intended primarily for applications where high-energy faults are unlikely. For high-energy applications, see the Model 815AT Three-Phase Fused Safety Voltage Probe Lead Set.

1.4.3 Three-Phase Voltage Lead Set, 813BT

The 813BT is identical in construction to the 813AT, except that this lead set is assembled with #16 AWG silicone-insulated lead wire. Silicone is our premier test lead wire. Highly flexible over a wider temperature range (-70 to +150°C, -100 to +300°F) than any other flexible insulation material, with excellent resistance to damage due to flame and heat, our silicone wire is highly recommended where safe operation is required with the possibility of high-current through faults.
1.4.4 3-Phase Spade Lug, Current Lead Set, 816AT

The 816AT is a three-phase current lead set, equipped with 1/4-inch spade lugs on both ends. Spade lugs are gold-plated for long life in demanding service, and have oversized barrels to accommodate our finely stranded test lead wire. This lead set is assembled with #10 Santoprene-insulated lead wire, has overall gray PET armor and a Velcro lead strap.

![Figure 1.3: 816AT (A-phase) Current Lead Set](image)

1.4.5 3-Phase Spade Lug, Current Lead Set. 916CT

Identical to the 816AT, the 916CT is constructed with silicone-insulated lead wire, instead of Santoprene-insulated lead wire. Silicone is our premier test lead wire. Highly flexible over a wider temperature range (-70 to +150°C, -100 to +300°F) than any other flexible insulation material, with excellent resistance to damage due to flame and heat, our silicone wire is highly recommended where safe operation is required with the possibility of high-current through faults.
1.4.6 Universal Test Plug Current Lead Set, 811AT

Assembled with our Universal Test Plug on one end and 1/4-inch spade lug on the other; compatible with ABB/Westinghouse, Superior, Meter Devices and States series test jacks. Materials and assembly are similar to the 816AT Three-Phase Spade Lug, Current Lead Set.

![Figure 1.4: 811AT (B-Phase) Universal Test Plug Current Lead Set](image)

1.4.7 Universal Test Plug Current Lead Set, 811CT

Identical to the 811AT, the 811CT is constructed with silicone-insulated lead wire, instead of Santoprene-insulated lead wire.

1.4.8 Universal Test Plug Current Shunt

Designed to allow indirect current measurement using a clamp-on current probe with the universal test plug adapter. Clamp the current probe over a loop of wire at the end of the test plug. AS0079001, red; AS0079002, yellow; AS0079003, blue; AS0079030, three phase – red, yellow, blue.
1.4.9 Adjustable Bail

Order the adjustable handle/bail assembly (part no. AS0035901) for convenient bench top use that allows positioning the Model 933A at common angles to the viewer. Adjust handle/bail by loosening the two fastening knobs, moving the handle/bail to the desired position and tightening the two fastening knobs.

![Figure 1.5: 933A Case Bail Assembly](image)

1.4.10 400 Amp, 20:1 Precision CT

The Arbiter Systems, Inc. Model 09311A 20:1 Auxiliary Current Transformer extends the outstanding accuracy, features and performance of the Model 933A Portable Power Sentinel by increasing the current input capability to 400 Amperes. Due to the careful design of the Model 09311A Auxiliary CT, overall accuracy exceeds 0.1% of reading and 0.1 degrees over the entire input current range of 1 to 400 amperes.
1.4.11 Clamp-on Current Probes for the 933A

**AP0012300:** 100:1, 0.1 – 150 Amp, 10mV/A, EN61010, 600 V, Cat.III. Use only with 933A-02 or 933A-03 low current modules.

**AP0012800:** 1000:1, 0.1 – 150 Amp, 1mA/A, EN61010, 600 V, Cat. III. May be used with 933A-01 standard current module. Best with 933A-02 or 933A-03 low current modules because of their greater sensitivity.

**AP0012900:** Has three ranges: 250:5, 500:5, 1000:5; 20mA/A–250A max; 10mA/A–500A max; 5mA/A–1000A max; EN61010, Cat. III. Use with any current module.

**AP0001300:** 1000:1, 1000A max, 1mA/A, EN61010, 600 V, Cat.III. Use with any current module. Best with 933A-02 or 933A-03 because of their greater sensitivity.

1.4.12 Low Current Modules

Two low-current input modules are available for both current-output and voltage-output CT’s. Each has two ranges; a high range (up to 1.2 Arms or 2.4 Vrms) and low range (up to 50 mA rms and 100 mV rms) These two modules are very similar except for the input connectors. The 933A-02 (order no. AS0097800) has two sets of shrouded banana connectors for each phase, including neutral, that include a voltage input and current input. The 933A-03 (order no. AS0097900) has a unique single jack that allows for voltage and current input signals. Arbiter Systems produces dedicated cable assemblies for the Model 933A-03 to work with this current module.

Figure 1.6: 933A-02 and 933A-03 Low Current Modules
1.4.13 GPS Antenna Module

To synchronize the 933A with the GPS, order the GPS Antenna Module (Part No. AS0077600). It includes a 50-feet cable assembly that attaches between the front panel of the 933A and the GPS module. The antenna module provides the best accuracy for 933A timing measurements.

Operating at the standard GPS frequency (L1 band) of 1575.42 MHz, the antenna module receives power from the 933A through the cable assembly. The same cable assembly communicates time and position data via RS-485 to the 933A.

If connected before power up, the Model 933A automatically recognizes the GPS module and sets the internal clock on the Model 933A to the correct time. If the GPS module is connected after power up, use the manual programming function to synchronize the 933A (see page 38). The photo below shows the standard cable assembly and the magnet-mounting bracket.

![Figure 1.7: GPS Antenna Module and Cable Assembly](image-url)
1.4.14 Auxiliary I/O Module

The AS0077700, Auxiliary I/O Module, connects to the Model 933A Auxiliary I/O input connector and has two main features:

- Four Event Input connections
- Three sets of relay contacts: two Form-C, mechanical contacts and one solid-state contact (KYZ rated)

**Event Input Configuration**

See page 115 for information on setting up the Event Inputs in the External I/O Module.

**Relay Contact Configuration**

See page 117 for information on setting up the three relay contacts in the External I/O Module.

![Figure 1.8: External I/O Module and Cable Assembly](image)
1.5 Safety Information

Read the safety information before using the Arbiter Model 933A. Specific warning and caution statements, where they apply, will be found throughout the manual.

In general, be very careful when working around high voltages and sources of current. It is possible to receive an electrical shock that could severely injure you or cause death.

1.5.1 Definitions

- A “Warning” identifies conditions and actions that may pose hazard(s) to the user.

- A “Caution” identifies conditions and actions that may adversely affect the performance of, or damage, the Arbiter Model 933A.

- Read the Safety Information in the manual.

1.5.2 Terminology

The terms “Isolated” or “Electrically Floating” are used in this manual to indicate a measurement in which the Model 933A is not connected to earth ground through the ground terminal on the front panel.

The term “Grounded” in this manual refers to a measurement in which the Model 933A is connected to an earth ground.

Ground Lug

The purpose of the ground lug is to connect the chassis to a safety ground, especially during battery operation.

Current Probe

Arbiter Systems may supply various current probes based on availability, and considers them as accessories to the Model 933A. Make sure to stay within the limitations of the 933A if supplying your own current probe.

1.5.3 Warnings

- The maximum allowable input to either set of Voltage terminals is 650 Vrms. Over range is 1200 Vpeak, nominal.
- The maximum allowable input to the current terminals is 40 A peak and 20 Arms continuous.

- Remove all test leads that are not in use.

- The front-panel ground terminal should always be connected to the safety ground for the circuit under test. This is especially critical for operation with the line cord unplugged, since the AC line input safety ground will not be connected.

- Do not use the Safety Ground connector on the front panel as a voltage or current input connection point.

- Use extreme caution when clamping the current probe(s) around non-insulated conductors or buss bars.

- Never use the current probe on circuits rated higher than 600 Vrms in overvoltage category III (CAT III) or EN/IEC61010-1.

- Keep your fingers behind the finger guard.

- Do not use a probe that is cracked, damaged, or has a defective cable. Such probes should be made inoperative by taping the clamp shut to prevent operation.
Chapter 2

Basic Operation

2.1 Introduction

“Basic Operation” describes all of the 933A keys, connectors and menus, and how to operate the Model 933A primarily from the front panel buttons. You may also remotely control the 933A from a computer running PSCSV application software. Additional information on PSCSV software is located throughout the manual where needed and in Chapter 6, entitled, “PSCSV Basics.”

2.2 Powering the Model 933A

2.2.1 Operation with the AC Power Cord

The Model 933A can be operated from an AC outlet or from an internal rechargeable battery pack. To operate with the AC power cord:

1. Plug the power cord into the AC outlet (see External Power, under Specifications).
2. Connect the power cord to the 933A.
3. Press the ON/OFF key to turn on the 933A and the splash screen will appear on the display.
4. Following the splash screen, the 933A will settle on the DISPLAY SELECTION screen for viewing measurements.
2.2.2 Operation with Battery Power

The Model 933A comes equipped with an internal, NiMH battery pack; charge by connecting the 933A with the included power cord to an AC outlet, or external DC Power. Under battery power, the Model 933A should run for at least 8 hours on a full charge. Operating the 933A using the LCD backlight will reduce the operating time.

2.2.3 Charging the Internal Battery

To charge completely,

- Connect the power cord between the outlet and the 933A.
- Power OFF the 933A and charge for at least 5 hours.

A battery charge level indicator is visible as part of the Status Indicators in most of the data viewing screens. The level of charge is indicated by the dark color in the battery symbol. The battery symbol in the screenshot below indicates that the charge level of the internal battery is full.

![Battery Symbol](image)

**Warning**

When operating the 933A under battery power, make sure to connect the ground lug on the front panel to a handy ground point (see Chassis Ground later in this section). Otherwise, the 933A will be floating.

For more information on battery status, please see Section 2.4.12.
Battery information is also available when selecting configuration and status information. Select DISPLAY > 9-Config & Status > BATTERY & FLASH (soft key) to view the screen shot in Figure 2.1.

**BATTERY STATUS**

Values listed under BATTERY STATUS are for factory use when trouble shooting a problem with the unit. You may be asked to report these values if you suspect a battery problem.

![Battery and Flash Status Screen](image)

Figure 2.1: Battery and Flash Status Screen

### 2.3 Controls and Connections

Figure 2.2 depicts the Model 933A’s front panel identifying the main functional groups of keys, connectors and display.
Figure 2.2: Front Panel Description
2.3.1 Inputs and Interface

Front Panel Keys
The 933A has thirty front-panel keys with the following general uses:

- Soft Function Keys (5)
- Dedicated Function Keys (8)
- Cursor control with Enter key (5)
- Numeric keypad (12)

2.3.2 Front Panel Connectors

Connectors on the 933A have the following purposes:

- Current (C) and voltage (V) input; (C) 4 (933A-03), 6 (933A-01), 16 (933A-02), (V) 4
- Ground/safety lug, banana
- Multiconductor GPS Timing Input; capped when not in use
- IRIG-B Timing Input connector, BNC
- USB 1.1 serial I/O communications
- RS-232C serial I/O communications, RJ11
- Multiconductor Auxiliary I/O; capped when not in use
- IEC-320 inlet power receptacle, with fuse compartment

2.3.3 Chassis Ground

A ground lug is located in the upper right portion of the front panel. This terminal is connected to the instrument chassis, and also to the safety ground lead of the AC power connector. When the Model 933A is operated with the power line cord connected, the chassis of the instrument will be connected to the safety ground for the AC outlet. However, when operated from the internal battery with the power cord disconnected, the chassis will be floating.

The purpose of the ground lug is to allow the chassis to be tied to a safety ground, especially during battery operation.

**CAUTION: Do not use a 3-to-2 prong plug adapter on the ac power cord.** This will isolate the safety ground on the instrument from a ground point and cause a dangerous condition.
2.3.4 Voltage Inputs, 650 Vrms

Four input connectors are available for measuring AC voltages. All four of the inputs use identical circuitry, which allow for measurement of voltages up to 650 Vrms between inputs. See Figure 2.3 below.

Safety-insulated banana jacks are used to connect voltage signals to the 933A, are labeled “A”, “B”, “C”, “N” (for phase A, phase B, phase C and Neutral, respectively), and have one megohm voltage dividers tied to a common point. Any unused voltage input will float at the average value of the used inputs. You can measure voltage between any two of the inputs (e.g., A and N, or A and B), including any input and a synthesized neutral. Synthesized neutral is the average of the voltages at inputs A, B, and C. The 933 does not directly measure Vac or Vbc.

2.3.5 Current Input Module, 20 Arms (933A-01)

The Model 933A-01 Current Module has three inputs, A, B and C, for use in AC current measurement. Each of the inputs uses a pair of five-way binding posts, and has a maximum continuous current capability of 20 amps rms. Peak current is 40 Arms, maximum. See Figure 2.3 below. For information on alternate plug-in modules (933A-02 and 933A-03) that offer lower current ranges and different connector styles, see Section 1.4.12. Optional modules provide connectors for measuring neutral current.

![Figure 2.3: Voltage and Current Inputs](image-url)
2.3.6 Synchronizing the 933A

Synchronize the 933A with either an Arbiter GPS Module (AS0077600) or unmodulated IRIG-B time signal. Either of these two external timing signals will keep all the 933A measurements synchronized.

When not connected to an external timing signal, the internal clock runs off of the crystal oscillator and typically has a drift of less than one second per day. When connected to the GPS, the time base error is less than 1 microsecond when locked to at least one satellite. When locked to an IRIG-B signal, the time base error will be less than one microsecond plus the accuracy of the IRIG-B source.

Using the accessory GPS module (see Section 1.4.13), or an available unmodulated IRIG-B signal, you can easily connect these signals to the Model 933A for additional accuracy and synchronized measurements. The following paragraphs will assist you with setting up and using these features.

2.3.7 GPS Timing Signals

To use the Global Positioning System (GPS) as the phase reference for synchronizing the 933A you must have the Arbiter GPS module connected to the GPS connector located on the 933A front panel. Also, the GPS module must be locked to the GPS. Since the GPS receiver and antenna are housed in the same (external) module, it receives power from the 933A and sends down-converted timing signals through the cable via RS-485.

GPS Setup

1. Mount the GPS module in a stable manner in which the antenna module has a clear view of the sky in all directions. If this is not possible, a partial view of the sky may also work.

2. Turn the 933A OFF and connect the cable from the GPS module to the GPS Receiver connector on the 933A

3. Press the power switch to turn on the 933A.

4. Once connected and operating, the 933A should detect the presence of the GPS signal as the time reference. If you connect the GPS signal with the 933A powered on, you will need to select SETUP > 1-Clock Time Set > ACTIVATE GPS RCVR.
2.3.8  IRIG-B Timing Signals

To accurately synchronize the 933A to an IRIG-B signal as a reference, you must have a good IRIG-B signal connected to the IRIG-B IEEE 1344 BNC connector on the 933A. This is an unmodulated IRIG-B (DC Level Shift) signal. See also Clock Setup in Synchronized Mode in Section 3.3.3.

IRIG-B Setup

1. Connect the IRIG-B signal cable to the IRIG-B connector (BNC) on the front panel of the 933A.

2. Once connected and operating, the 933A will automatically detect the presence of the IRIG-B signal and adjust the internal real-time clock.

2.3.9  Communication Ports

The Model 933A has two communications ports located on the front panel; USB 1.1 and RS-232C. Both communication ports serve to provide a configuration and data acquisition link to the 933A.

Use PSCSV to maximize the operation of the 933A. While most features are available from the front-panel keys, use PSCSV to configure features and also to download data.

The Model 933A can also send a single bitmapped file to a terminal or computer running a terminal program by pressing the Print key. For more information on downloading bitmapped data, see Bitmapped File Downloading at the end of this chapter.

USB 1.1

To connect to the 933A USB port, the pc requires a virtual COM port be set up on it. Virtual COM port (VCP) drivers cause the USB device (i.e. 933A) to appear as an additional COM port available to the PC. In this way, PSCSV application software can access the 933A USB port in the same way as it would access a standard COM port. Therefore, to use the USB port on the 933A, you must install the 933_FTDI_USB_Driver, an available download from the Arbiter website. To connect using the USB port, see Section 6.2.4 in “PSCSV Basics”.

21
RS-232C

For RS-232C communications use PSCSV, or for bitmapped downloads use a terminal program like HyperTerminal. Access the RS-232 port through a small RJ11 connector on the front panel using the included 6-foot phone cord and RJ11 to DB-9F null-modem adapter. To connect the 933A to a computer using PSCSV, see Chapter 6, “PSCSV Basics.” To connect using a Terminal program, see “Bitmapped File Downloading” in Section 2.6.

2.3.10 Auxiliary I/O Port

The Auxiliary I/O port provides a connection between the Auxiliary I/O Module (part no. AS0077700) and the 933A using the accessory cable assembly. The Auxiliary I/O Module includes four event input connections and three contact outputs: 2 Form-C mechanical contacts and one solid-state contact. Connect wiring to the module using the screw-terminal strip connectors.

2.3.11 IEC-320 Power Inlet Connector

To provide a connection to a wide range of AC and DC power inlet sources, the 933A has one IEC-320 Power Inlet Connector. AC sources include voltages between 85 to 264 Vac at 47 to 63 Hz, and DC sources from 110 to 275 Vdc. A small door at the bottom of the connector contains a fuse and space for a spare fuse.

Replacing a Fuse

1. Make sure that the 933A is powered OFF and disconnect the power cord if attached.

2. Using a small flat-blade screwdriver, pry open the small fuse door below the power connector. Pull it out toward you.

3. The innermost fuse is the one being used, and the fuse closest to the door is a spare.

4. Check the suspected fuse for being open, and replace only with a fuse of the same type.

Replacement Fuse, Part No. FU0001816; 1A, 250V, fast acting, 5 x 20-mm (diameter x length)
2.4 Function Keys & Indicators

In the following pages you will find descriptions for the main functions of the Model 933A. Access these functions through either PSCSV, or by using the 30 front-panel keys. Each key is inscribed with a specific function name or symbol depicting the function.

- Eight specific function keys include: Power ON/OFF, Display Backlighting, Display Functions, Review, Log (Data), Setup (instrument), Print (a record) and Hold (a reading)
- Twelve numeric data entry keys: data entry or function selection
- Five cursor control keys: right, left, up, down and Enter
- Five soft function keys; change with function

2.4.1 On/Off Key

Quickly, press and release the On/Off key to switch the power to the 933A on. Press for approximately 1/2 second and release to power off. This helps prevent you from inadvertently powering off the Model 933A.

2.4.2 Display Selection Key

Press the DISPLAY key to select the type of data you want to view on the 933A display. This includes the active signal(s) connected to the 933A and all of the DSP-related parameters. It also includes any stored records and related data residing in flash memory. Select to view data using the associated number key, or with the up or down cursor key, then pressing the enter key. Selecting “9-Config & Status” submenu also provides firmware version and battery and current flash information.

Figure 2.4: Display Key Menus
2.4.3 Setup – Configuring the 933A

Press the Setup key to configure all of the features controlling the operation of the 933A. For example, before actually connecting the 933A to a circuit, it should be configured to match the measured electrical system. Whether it is single phase or three phase, with one, two, or three elements, the 933A is adaptable to most of the commonly-wired systems. Configure triggers from the setup menu so that the 933A is ready to record events when they occur. Also, you can set up the Autolog feature to automatically record the connected signals on a specific day and over a set time interval. For accurate low currents measurements, configure the 933A with one of the low-current modules (see Sections 1.4.12 and 3.8).

Chapter 3 covers all of the setup and configuration features that control how the 933A operates. This includes the type of measured electrical system, setting up the internal clock, setting up the serial (RS-232) port, configuring the automatic data logging features, setting up current transformers and potential transformers, setting up current modules and triggering.

2.4.4 Five Soft Keys

Press any of these keys when the correct label appears in the lower line of the display that indicates your choice. These keys may change function whenever a specific function key, or other soft key, is pressed.
2.4.5 Display Lighting Key

Press the Display key to view the display lighting menu and adjust it. Three display menu choices are available: BACKLIGHT ON, BACKLIGHT OFF and BACKLIGHT AUTO-OFF. BACKLIGHT AUTO-OFF provides display backlighting for a period of 10 minutes and shuts off the backlighting after 10 minutes have expired to save the internal battery and extend the lifetime of the backlight. The cursor keys provide control over the backlight intensity and contrast. See Figure 2.7.

![Figure 2.7: Brightness Contrast Adjustment](image)

Auto-Off and Backlight Life Expectancy

Note: Backlight life expectancy is about 1000 hours. Therefore, it is good to use the Auto-Off feature to prolong the use of the backlight. If you do intend to use the Display ON feature, it would be wise to turn it off at the end of a sustained period of use.

2.4.6 Cursor Keypad / Enter Key

Press any of the Cursor Keys, including the Enter Key (the central key with dot), to move through menu choices and to make selections. See Figure 2.8 below.

![Figure 2.8: Numeric and Cursor Keypad](image)
2.4.7 Numeric Keypad

Use any of the numeric keys to select various menu items or to enter data into the Model 933A. When entering numeric data, use the right or left arrow key to move the cursor to the right or left digits – see Figure 2.8.

2.4.8 Log Key

Press the Log key to immediately record a complete set of data to flash memory. When retrieving data, the record type will be listed as “K” (see below under Review Key).

2.4.9 Review Key

Press the Review key to view the contents of records stored in the flash memory module. Records are displayed in chronological order according to date and time and contain various identifiers, including what initiated the recording. For more information on reviewing recorded data, go to Chapter 5.

- Autolog recording - record type “A”
- Pressing the LOG button - record type “K”
- User Triggers - record type “T” (Trigger with up/down arrow indicating that the trigger is active/inactive)
- Power Quality Triggers - includes high-speed waveform records (T)
- Triggered from optional External I/O Module (T)

Review Key Selections

Press the number of the record displayed (0 – 9) to select and view specific data. Use Arrow keys to scroll through logged data.

2.4.10 Print Key

Press the Print key to send the information, exactly as it appears on the 933A display, to the RS-232 port. The 933A sends out this information in a bitmapped file format. Therefore, to receive this file, you would need to have a terminal program running and set to the same RS-232C port settings as in the 933A. See “Serial Setup (RS-232 Port Settings)” later in this chapter. The file size is normally about 10 kilobytes.

Format: X Modem - CRC
Use the DISPLAY key to cancel the transfer.

To capture a bitmapped file, use a terminal program, like Hyper Terminal or Tera Term Pro; See Section 2.6 “Bitmapped File Downloading” later in this chapter.

### 2.4.11 Hold Key

Press the Hold key to alternate between the Measurement Mode and Hold Mode. The Hold Mode freezes the display and displays the current data at the time that you press the Hold key. During the Measurement Mode, the indicator in the meter symbol is moving. The 933A is normally placed in Hold Mode when reviewing data recorded in flash memory.

### 2.4.12 933A Status Indicators

A set of status indicators, located in the lower left corner of the 933A display, describe the instrument operating modes, including time and date. These symbols appear when viewing any data, except waveform, in the Measurement or Hold Mode. Figure 2.9 below provides definitions for each of these indicators.

![Status Indicator Definitions](image)

**Figure 2.9: Status Indicator Definitions**

**Battery Level**

On a full charge, the battery symbol should be completely dark and the battery giving the 933A about 8 hours of operation. When the battery is drained, the symbol appears as an outline of the battery symbol and may have the letter L to indicate that the charge is Low, or the letter C to indicate that it is charging.
Data Modes

There are five data modes for storing and handling data, including (1) Key Logging — logging one record to flash by pressing the LOG key, (2) Auto Logging — logging multiple records to flash using the Autolog feature, (3) Trigger Log — notification of triggered data being held in flash, (4) Review Data — notice that you are reviewing data stored in flash, and (5) Send Data — stored data being sent to one of the communication ports.

Timing Modes

There are three timing modes: (1) Unlocked — the free-running internal clock, (2) Locked to IRIG-B — internal clock synchronized to an incoming unmodulated IRIG-B signal, and (3) Locked to GPS — internal clock synchronized to an incoming GPS signal. When synchronized, we refer to the internal clock as being “Locked.”

Viewing Modes

There are two viewing modes: (1) Measurement Mode, and (2) Hold Mode. Press the HOLD key to alternate between the Measurement Mode and Hold Mode. The Hold Mode freezes the display and displays the current data at the time that you press the HOLD key. During the Measurement Mode, the indicator in the meter symbol is moving.

Date and Time

The 933A status indicators also provide you with the current Date, Day of Week, and Time. In free running mode, you must manually set the date and time for them to be correct. With a connected IRIG-B or GPS synchronizing signal, the date and time are set automatically, and kept accurate. Note: Use the correct IRIG-B type. Set the clock source to unmodulated IRIG-B, with IEEE 1344 Mode ON. Status Indicators will state NO DATE DATA and NO TIME DATA if set to any other type of IRIG-B.

Internal Clock

The internal clock has three modes: (1) free running based on the internal oscillator, (2) synchronized by an external IRIG-B signal, and (3) synchronized by an external GPS signal. Timing Mode indicators show the current mode as seen in the main figure on the previous page.
In the free-running mode, the clock drift is based on both the physical characteristics of the clock and operating environment; namely, the ambient temperature. Unlocked, the clock accuracy is less than 10 PPM and less than 1 second per day, typical. Make sure to check and, if necessary, set the clock time before important measurements. If not, time-based measurements, such as set up under the Autolog mode, may not occur as anticipated.

Synchronized to an IRIG-B signal, the accuracy will be 1 microsecond plus the accuracy of the IRIG-B signal. The 933A indicates IRIG-B synchronization with a symbol of a digital signal. The internal clock will be set only if the IRIG-B is unmodulated and according to the IEEE 1344 standard.

Synchronized to the GPS, the accuracy is 1 microsecond. The internal clock (time and date) will be set automatically.

2.5 PSCSV Software

PSCSV software is an included accessory with the 933A. It was developed by Arbiter Systems to assist you in configuring the 933A, for managing and downloading logged data. While most features are accessible from the front panel, some are only available with PSCSV. See “PSCSV Basics” in Chapter 6, and “Triggers and Event Recording” in Chapter 7.

2.5.1 USB or RS-232C

Connect to the 933A USB or RS-232C ports using PSCSV. Make sure that PSCSV is installed on your PC and connect a suitable cable between them. Included as an accessory is a DB-9F to RJ11 adapter and phone cord for connecting between the 933A and RS-232C port on a computer. If your computer does not have an RS-232 port, use a USB-to-RS-232 adapter.

2.5.2 Connecting

Before using PSCSV, make sure to read over the section on connecting in Chapter 6, PSCSV Basics. It is necessary to manually connect to the 933A from the computer running PSCSV.
2.5.3 Configuring
Configure all SETUP functions through PSCSV or through the front panel keys.

2.5.4 Downloading Data
When downloading data, all of the data is in binary format and can be located in the directory of your choice on the computer running PSCSV.

2.6 Bitmapped File Downloading
Purpose
The PRINT key has one basic function: to send a bitmapped file of the current display to the RS-232C port.

Procedure
1. Verify the RS-232 settings by selecting DISPLAY > 9- Config & Status. If you need to change the SERIAL settings, then you would press the SETUP key and 2- Serial Setup. Adjust the settings and go to step 2.

2. Open a terminal program of choice and make sure that the port settings agree with those from step 1 above. Change them if necessary.

3. Set the 933A to read the desired information on the display.

4. Set the terminal program to Transfer the file via Xmodem Receive. This is done with slight differences between programs.

5. When requested, give the file a name with a “bmp” extension, click OK and (when ready) press the PRINT key on the 933A.

6. Within a few seconds the file should transfer. You should see a number of bytes received. Generally about 9 kB. This time interval can vary between terminal programs and baud rates.
2.6.1 Tera Term Pro BMP File Transfer

To transfer a bitmap of the display using Tera Term Pro, use the same steps as in Section 2.6. You should normally select File > Transfer > XMODEM > Receive.

1. A file Save window should appear next. Type in the name with a bmp extension.

2. Make sure that CRC and Binary are selected and click Open.

3. The SaveAs window should disappear and a new download window should appear.

4. Press the PRINT key and you should see values that indicate that bytes are being transferred (up to about 9 kB) and disappear.
2.6.2 HyperTerminal BMP File Transfer

To transfer a bitmap of the display using Hyper Terminal, use the same steps as in Section 2.6. You should normally select Transfer > Receive File.

1. When the Receive File window appears, select the location for the new file capture and choose Xmodem. Now click the Receive button and type in a file name with a bmp extension.

2. Press the PRINT button on the 933A and wait for the transfer process to finish.

3. Normally, it takes at least 20 to 30 seconds for the file to begin transferring (when you will actually see some bytes changing that indicate a transfer is taking place).
Chapter 3

The Setup Menu

3.1 Setup Key

The Model 933A has two main function keys named DISPLAY and SETUP. Most of the interaction between the user and 933A will begin with these two keys. From the SETUP key you will be able to configure all of the 933A functions.

Press the Setup key to control the basic configuration of the 933A. Using the numeric keys, press the number to the left to configure the desired function. These are depicted in Figure 3.1.

![Setup Key Display]

Figure 3.1: Setup Key Display
3.2 Input Setup Menu

Use the Input Setup Menu to configure the 933A to correctly match the electrical system you are measuring. The 933A provides six standard choices including a method for customizing the input. A secondary menu allows you to select the frequency mode, bandwidth, frequency reference and phase reference.

![Input Setup Menu](image)

**NOTE:** The 933A will compute power and energy qualities when selecting one of these six standard configurations.

### 3.2.1 Selecting the System Input

1. Press the SETUP key to access the Input Setup Menu.

2. There are two methods to select the input type:

   (a) Use the UP/DOWN arrow keys to select the Input Configuration Type and press the Enter key to make the selection.

   (b) Using the number keypad, press the number corresponding to the desired Input Configuration (e.g. 0 - 3Ph4W3E).

3. Press the SAVE SETTING soft key to save the changes and return to the DISPLAY SELECTION menu.

4. Otherwise, press the NEXT soft key to proceed to the Custom Input Selection menu. The Custom Input Configuration menu allows you to choose the voltage and current inputs, frequency mode, frequency reference and phase reference.

**Configuration Settings Indicator**

![Configuration Settings Indicator](image)

**Note:** Input settings appear in the lower right corner of most data screens, and appear in a small outline of the 933A. The input settings are written inside the outline.
Custom Input Configuration Selection

Choose the Custom Input Configuration menu if you want to individually select the inputs and reference signals. This includes input signals, nominal frequency (50 Hz, 60 Hz), choice of signal for frequency reference and phase reference. Choose “Absolute” for Phase Reference if you have a GPS or IRIG-B input.

Figure 3.3: Custom Input Configuration

To select Input Configuration:

NOTE: Normally, this menu is entered from the Input Configuration menu found on the previous page.

1. Press Setup > Input Setup Menu > NEXT (soft key).

2. Use the Arrow and Enter keys to locate and select the Input signal(s), Frequency Mode, Bandwidth, Frequency Reference, and Phase Reference.

3. When finished, press the SAVE SETTING soft key, returning you to the DISPLAY SELECTION menu.

4. Press the BACK soft key if you want to return to the initial Input Configuration Menu.

Synchrophasors

For synchrophasor measurement, you must select Absolute, under Phase Ref. For viewing phasors on the 933A itself, see Section 4.10. For additional information on using the 933A as a PMU and viewing phasors using PSCSV, see Figure 6.5.

Bandwidth

Measurement bandwidth allows you to set up how the 933A calculates Volt-Amps \((VA = V_{mag} \times I_{mag})\), Volt-Amps Reactance \((VAR = \sqrt{VA^2 - W^2})\), and Power Factor \((PF = W \div VA)\). Wide band mode includes the contributions of harmonics in the calculation of VA, PF and VAR.
3.3 Clock Time Set

3.3.1 Internal Real-Time Clock

Before making measurements, take time to set up the real-time Clock. Capable of operating in three different modes, each clock mode offers different performance advantages. Whatever mode you ultimately decide to use, it is important to understand the performance differences, and to configure the clock so that the clock performance matches your expectations.

Figure 3.4: Clock Setup

Clock Operating Modes

There are three clock-operating modes from which to choose: (1) free running, (2) synchronized to the GPS, and (3) synchronized to IRIG-B. For a complete list of specifications, please see Chapter 8.

Free Running
Clock time is based on the internal oscillator, with no external timing input for stabilization. Clock time depends on initial setup, with a characteristic drift of less than 1 second per day.

Synchronized to an External IRIG-B signal
Uses an IRIG-B signal from an external clock to synchronize the internal clock of the 933A. Accuracy: Better than 1 microsecond plus the accuracy of the IRIG-B source.

Synchronized to an External GPS Signal
Use the accessory GPS module (see Section 1.4.13) to synchronize the internal clock of the 933A to the GPS time standard. Accuracy: Better than 1 microsecond.
3.3.2 Clock Setup in Free-Running Mode

In free running mode the internal oscillator in the 933A is not disciplined by an external clock signal, such as IRIG-B or GPS. When manually setting the internal clock on the 933A always set it to your Local time. Verify this in the second line of Figure 3.4, which states, **Instrument Time:LOCAL**. If it says, **Instrument Time:UTC**, you will need to press the far left soft key, SELECT LOCAL, to switch it to local time.

**TIP:** In free running mode, use an accurate external time source as a reference and set the 933A time ahead enough so that you can “set it” when the reference time arrives at the top of minute. The Model 933A clock time is “set” when you press the SAVE CHANGES soft key.

**Setting up the Internal Clock**

1. Press SETUP, then select 1-Clock Time Set to access the internal clock setup menus.

2. TIME ZONE. If necessary press the UP or DOWN key to adjust the Local Offset to your time zone.

3. DST Preference. Press the NEXT ENTRY soft key and press the UP or DOWN key to adjust the Daylight Saving Time to your preference: OFF, ON, Auto USA, Auto EUR, Auto AUSS, Auto AUST, Auto NZEL, Custom.

4. YEAR. Press the NEXT ENTRY soft key and enter the year information from the numeric keypad – the Local Time symbol should then appear to the right of the year indication.

5. MONTH. Press the NEXT ENTRY soft key and using the UP or DOWN keys, enter the current month.

6. DAY. Press the NEXT ENTRY soft key and adjust the Day using the numeric keypad.

7. HOUR. Press the NEXT ENTRY soft key and adjust the Hour using the numeric keypad.

8. MINUTE. Press the NEXT ENTRY soft key and adjust the Minutes using the numeric keypad.

9. Press the SAVE CHANGES soft key before leaving this menu.
3.3.3 Clock Setup in Synchronized Mode

1. Set the internal clock in the free-running mode as described in Section 3.3.2.

2. Connect the timing signal from an IRIG-B or GPS source.

3. Check your clock settings. Make any changes as required.

Select UTC or Local

1. Set the internal clock in the free-running mode as described in Section 3.3.2.

2. If you wish to set the internal clock to Local Time, press the SELECT LOCAL soft key to set the system clock to your local time zone (Adds the offset in the ZONE menu including any DST offset).

3. If you wish to set the internal clock to UTC, press the SELECT UTC soft key.

4. Make sure to press the SAVE SETTINGS soft key before leaving the clock setup menu.

Notes on Using an External Timing Signal

When connecting an external IRIG-B timing signal, be sure that the source clock is transmitting UTC and IEEE 1344 mode ON. This is because the 933A will add the Local Offset (including sign) to the time received from the source clock, and needs the calendar year.

For example, if you are located in the Pacific Time Zone of North America, the Local Offset would most likely be - 8 hours. If the external clock is sending local time (i.e. Pacific Time), then the 933A internal clock will indicate 8 hours earlier than expected.

When using a GPS module, remember that the GPS module always sends the time as UTC time, so that the 933A Local Offset should be set according to the normal method. For example, if you are located in the Eastern Time Zone for the United States, the Local Offset would be -5 hours.

Manually Programming GPS Module

To synchronize the 933A to the external GPS module (i.e. AS0077600, see page 10) after it is operating, select SETUP > 1-Clock Time Set >
ACTIVATE GPS RCVR (soft key). After it is programmed, you will see the GPS synchronizing symbol in the status indicators (see Figure 2.9).

### 3.4 Serial Setup

RS-232 port parameters include Baud Rate, Word Length, Stop Bits and Parity.

![Figure 3.5: RS-232 Setup](image)

#### 3.4.1 Setting up the RS-232 port

In each of the menus described below for specific port settings, use the cursor keys and Enter key to select the desired values.

1. Press the SETUP key and then choose 2-Serial Setup. To exit, press either the DISPLAY or the SETUP key.
2. Select the Baud Rate and press the Enter key.
3. Select the Length (word length) and press the Enter key.
4. Select the number of Stop Bits and press the Enter key.
5. Select the Parity and press the Enter key.
6. Press the SAVE SETTINGS soft key before leaving this menu, or any new settings will be lost.
3.5 Autolog Setup

If you need to automate the tasks of measuring and logging data to the internal flash memory card, then you may want to configure the Autolog feature. The purpose is to allow you to begin logging automatically at a specified time and date, at a chosen rate, and then quit.

Autolog requires a future start time, a recording rate and recording duration. You can program this feature through the soft keys located at the bottom of the display.

**Example:** Let’s suppose you need to record data for about fifteen minutes at 10 second intervals, starting on November 29th at 9:30:01 a.m. The starting screen at the left indicates no date and time, and the AUTO LOG ENABLE soft key is vacant. The completed configuration, shown on the right in Figure 3.6, indicates a start time, stop time with a total of 100 records.

To Configure Autolog Operation:

1. Press SETUP > 3-AutoLog Setup.
2. Press the AUTO LOG START soft key and set the date and time by selecting Minutes, Hours, Days/Year when the soft keys change. When finished with Start, press the Exit Start key.
3. Press the AUTO LOG RATE soft key to select the measurement interval; select in hours, minutes and seconds. When finished with Rate, press the EXIT RATE soft key.
4. Press the AUTO LOG DURATION soft key to set the stop time for the measurement. Duration really means (for the above example)
“How many 10-second intervals do you want?” For 15 minutes, this means 100 intervals (realize that the first record occurs at 9:30:00 a.m.). When finished, press the EXIT DURATION soft key.

5. Press the AUTO LOG ENABLE soft key to arm the Autolog feature so that the 933A begins measuring when its clock reaches the Start Time. **NOTE: the AUTO LOG ENABLE will be vacant without a future start time and date to the internal clock.**

### 3.5.1 Logging Data Indication

When the Autolog start time is reached, the 933A will begin logging data based on the connected input signals and Auto-log Rate. Auto-log Entries (shown as “0” in Figure 3.6) begin incrementing with each new record stored. “AL”, appearing within the Status Indicators, indicates logging activity. Autolog indication is described in Figure 2.9.

![Figure 3.7: Review Log Data](image)

**To Access Recorded Data**

1. Press REVIEW key > SHOW LOG (soft key).
2. Press REVIEW SELECTIONS (soft key) > SHOW AUTO LOG (soft key). This sorts Autolog data from other logged data.
3. Press the number keypad corresponding to the index number at the left of the record. This will open the DISPLAY SELECTIONS menu, as if you pressed DISPLAY key. Now, press the number of the data type you wish to view.
4. Press any other number key to change data types (i.e. that corresponds with the Display key).

When viewing recorded data, the instrument is effectively in HOLD mode and is symbolized by a small magnifier icon among the Status Indicators. This is shown at the right of the battery symbol in Figure 2.9.
3.6 CT/PT Setup

To automatically compensate for CT’s and PT’s (current and potential transformers), the 933A provides the CT/PT Setup menu to install these constants. By doing this, the 933A can directly display the primary current or voltage by converting the actual secondary current or voltage to the primary value. It does this by multiplying the secondary current or voltage by the CT/PT ratio and adding the phase difference to zero reference phase.

In the CT/PT Setup menu, you will find space to enter magnitudes and phase angles for each configured phase as seen in Figure 3.8.

![CT/PT Setup Menu](image)

**Setting up CT & PT Values:**

1. Press the Setup key and choose 4-CT/PT Setup.

2. Use any of the cursor keys to select the desired value (e.g. A-PHASE CT RATIO). The rectangle will surround the chosen value and it will be described in large letters in the lower portion of the display.

3. Use the number keys to enter the CT ratio or phase offset and press ENTER to install.

4. If the value is nominal for all phases press the APPLY TO A, B & C soft key.

5. Press the SAVE ALL soft key to save the new CT/PT values.

**CT Table**

The method above allows a single calibration point for each phase CT. Using the PSCSV-933A application software, a 12-point CT table may be entered into the 933A that compensates for a broad operating range. See Section 6.2.5 for more information on entering a CT table.
3.7 Custom DST Setup

Use the Custom DST (Daylight Saving Time) Setup if you want to customize the daylight saving changeover feature to one that is not offered under Clock Time Set. Features include setting the start and stop date and time. To set the internal clock, see Section 3.3.2, Clock Setup in Free Running Mode.

To Set up Custom DST

1. Press SETUP > 5-Custom DST Setup.
2. Press the ADJUST START soft key.
3. Press the YEAR soft key and UP/DOWN arrows to adjust the value for the next occurring.
4. Press the MONTH soft key and UP/DOWN arrow keys to adjust the starting month.
5. Press the DAY soft key and the UP/DOWN arrow key to adjust the starting Day of Week.
6. Press the HOUR/MINUTE soft key and the UP/DOWN arrow key to adjust the starting hour and minute.
7. Press the EXIT/ADJUST soft key to return to the previous menu.
8. Press the ADJUST STOP soft key to adjust the DST ending date and time. Use the same method as with ADJUST START.
9. Make sure to press the SAVE SETTINGs soft key before leaving the Custom DST Setup menu. Otherwise, press either EXIT NO SAVE.

Figure 3.9: Custom DST Setup Menu
3.8 Current Setup

Use Current Setup to adjust the current input sensitivity by a factor of approximately 20. Adjustable settings are either 1 or 20 Amps for each channel (A, B, C or N). By switching to 1 Amp, you are increasing the sensitivity of any one, or all, of the current input channels. Switching to 20 Amps, removes the current input preamplifier thereby reducing the sensitivity.

Note: Over driving the 933A current input (to greater than 1 Amp) when configured to the 1 Amp range will not damage the unit, however it will saturate the input amplifier and may produce unwanted harmonics.

To Setup the Current Range Sensitivity

1. Press the Setup key and choose 6-Current Setup.
2. Press the CHANGE CHANNEL A, CHANNEL B, CHANNEL C and CHANNEL N soft keys individually to toggle any or all of the channels to the preferred range – high or low current.
3. Press END MODIFY soft key and SAVE SETTINGS to save the changes made to Current Module Settings.
4. Press the EXIT soft key to leave this menu without changes.

Low Current Modules – 933A-02, 933A-03. The 933A-02 and 933A-03 Low Current Modules also include two ranges, and accept input voltages as well as input currents. This allows them to work with current-output or voltage-output CTs. For further information on these optional modules, see Section 3.9.

The 1-Amp setting has 1% accuracy compared to 0.05% accuracy for the 20 Amp setting.
3.9 Using Optional Low Current Modules

Two low-current input modules for the Model 933A are available for both current-output and voltage-output CT’s. Each has two operating ranges; a high range (up to 1.2 Arms or 2.4 Vrms) and low range (up to 50 mA rms and 100 mV rms) Both modules are identical except for the input connectors. The 933A-02 has two sets of shrouded banana connectors for each phase, including neutral, voltage and current inputs. The 933A-03 has a unique single jack that allows for voltage and current input signals. Arbiter Systems produces dedicated cable assemblies (purchased separately) for the Model 933A-03.

![Current Module Settings](image)

**Figure 3.11: Low Current Module Setup Menus**

3.9.1 Installing

To configure either the 933A-02 or the 933A-03, you will need to replace the current module already installed in the 933A with the 933-02 or 933-03. The expected current and voltage ranges will not appear without installing the specific current module.

*Make sure to power OFF the Model 933A before replacing a current module. Keep your fingers away from the ON/OFF Power Switch!*

1. Loosen the hold-down screws using a medium slot screwdriver.
2. Grasp the module and pull it out slowly.
3. Align the new module into the nylon guides and gently slide it into the slot guides.
4. Tighten the two hold-down screws to secure the module.
5. Start the 933A and press the SETUP key and 6-Current Setup to check the settings displayed for the module (as seen in Figure 3.11). Select range as desired.
3.9.2 Configuring

Before using the current module, make sure to press the SETUP key, then 6—Current Setup to configure the range. You should see the screen/menu similar to that shown in Figure 3.11.

Notice from the table in screen shot that there are two ranges for current and two ranges for voltage. The two ranges for current are 50 mA and 1.2 Amp. The two ranges for voltage are 100 mV and 2.4 Volts.

Soft key Selections

1. Make sure to press the MODIFY RANGE soft key to select the desired current or voltage input range for each channel.

2. Press the MODIFY INPUT soft key and select either current or voltage corresponding to the input type.

3. Before leaving this menu, press the SAVE SETTINGS soft key. To leave without saving press the EXIT soft key.

3.10 Trigger Setup

The last selection in the setup selection screen is called “Trigger Setup.” Triggers allow the Model 933A to automatically record to internal flash specific data when either the measured input signal, or calculated DSP value, meets the defined conditions.

The example Trigger Setup shown below illustrates the configured fields to trigger an event when the A-phase voltage exceeds 130 Vrms. For complete details on setting up triggers, go to Chapter 7, Triggers and Event Recording.

Figure 3.12: Trigger Review Menu
Chapter 4

The Display Menu

4.1 Display Selection

Press the DISPLAY key to select and view the various electrical measurements. This includes the active signal(s) connected to the 933A and any data stored on flash. When using the REVIEW key to view recorded data, the Display Selection menu is again used to help you select the type of data. This is possible because the Model 933A stores a complete set of data for each record. Press the number on the left corresponding to the data type you wish to view.

To change between display selections, press the number on the numeric keypad corresponding to the desired data type.

<table>
<thead>
<tr>
<th>DISPLAY SELECTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>0- Tabular Results</td>
</tr>
<tr>
<td>1- Harmonic Results</td>
</tr>
<tr>
<td>2- Waveform Display</td>
</tr>
<tr>
<td>3- V &amp; I Tabulation</td>
</tr>
<tr>
<td>4- Power Tabulation</td>
</tr>
<tr>
<td>5- Power Quality</td>
</tr>
<tr>
<td>6- Energy Tabulation</td>
</tr>
<tr>
<td>7- Phasor Display</td>
</tr>
<tr>
<td>8- Basic Data List</td>
</tr>
<tr>
<td>9- Config &amp; Status</td>
</tr>
</tbody>
</table>

*If 933A loses zero selection error*

Figure 4.1: Display Menu
4.2 Min–Max Setup

Use the Min–Max Setup, within any data display screen, to view the normal, minimum, maximum and average data values. To restart Min–Max accumulation, press the RESTART MIN/MAX in the Min–Max menu.

To select Min / Max / Average or Normal:

1. Press the DISPLAY key and choose 0-Tabular (or other Data Type selection key) to access the selections from the Min–Max menu.

2. Press the Min–Max SELECTION soft key to activate the Min–Max soft menu at the bottom of the display.

3. To view the minimum, maximum or average results, press any Min–Max function soft key below the display.

4. Press the RESTART Min–Max soft key to reset the minimum, maximum and average values to zero, and begin storing new values.

5. Press the EXIT Min–Max to return to the Phase A Results screen.

Note: Remember that the Min–Max function is always active from the time that the 933A is powered ON. It may be important to press the RESTART Min–Max if you are starting a new measurement and do not want any previous measurements (startup conditions, noise, etc.) included with your new measurement.
4.3 Tabular Results

Tabular Results include the measured electrical and power-related values for the selected phase, including minimum, maximum, average and normal. The figure below shows all of the A-phase tabular results.

![Figure 4.3: Tabular Results](image)

**Tabular Results include**

- all configured voltage & current phases
- phase angles (Vdeg, Ideg)
- active/reactive/apparent power (Watts, VARs & VA)
- power factor (PF)
- frequency (Hz)

Use the soft keys to select individual phases and totals. Use the separate soft key shown below the display to select Normal, Minimum, Maximum, or Average, and to Restart values.

Status Indicators also show the internal clock time and date, the current instrument configuration and also the charge level of the internal battery. For definitions of status indicators in the lower part of the display, see 933A Status Indicators in Section 2.4.12.
4.4 Harmonic Results

Harmonic Results includes all harmonics from the fundamental to the 50th harmonic for the specific phase voltage and current. Soft keys allow selection of phase and neutral.

4.4.1 Graphical Harmonics

Select 1−HARMONICS from the Display Selection menu to view Graphical Harmonics. Soft keys allow you to select each configured current and voltage. Press the MAGNIFY & TAB KEYS soft key to switch soft key menus for the magnify and tabular menu.

![Figure 4.4: Graphical Harmonics Display](image)

4.4.2 Tabular Harmonics

In the Graphical Harmonics display, press the MAGNIFY & TAB KEYS soft key, then press the TABULAR HARMONICS soft key. Press PREVIOUS 8 HARMONICS or NEXT 8 HARMONICS soft key to progress through tabular harmonic values. Press GRAPHICAL HARMONICS soft key to return to the previous display.

![Figure 4.5: Tabular Harmonics Display](image)
4.5 Waveform Display

Waveform Display indicates the waveforms of rms voltages and currents for the configured system. Also provides a magnification function for better viewing. Tabular values displayed at the bottom of the waveform display are instantaneous voltages and currents for configured system.

![Waveform Display](image)

**Figure 4.6: Waveform Display**

**To Display Waveform Results:**

1. Press the DISPLAY key and “2-Waveform Display” to view the waveforms.

2. Press the VOLTAGE WAVEFORMS soft key, CURRENT WAVEFORMS soft key, or V & A WAVEFORMS soft key to view the respective waveforms.

3. Press the MAGNIFY ON/OFF soft key to view the magnified individual waveforms only. New soft keys allow switching between phases.

**Note:** This display does not include a complete set of Instrument Status indicators (lower left of display) when viewing Waveforms.

**View Instantaneous Values**

Use the right and left cursor keys to move the vertical cursor for better viewing of peak values.
4.5.1 Magnify Waveforms

Magnify Waveform Press the MAGNIFY ON/OFF soft key to view a magnified display of the waveform. Use the right and left cursor keys to move the vertical line cursor for viewing instantaneous values. Soft keys allow you to separately view the voltage and current waveforms.

Figure 4.7: Magnified Waveform Display

Press the Magnify ON/OFF soft key to switch back to viewing the combined waveform results.

4.6 V & I Tabulation

Press the Display key and select 3-V&I Tabulation, to view all phase voltages, currents and neutral current. Select the Min–Max SELECTION soft key to switch between Normal / Minimum / Maximum / Average Results, and to Restart the counting for these results. For additional information on Min–Max selection, see Section 4.2.

Figure 4.8: Voltage & Current Tabulation
4.6.1 Show Sequence

Press the Show Sequence soft key to replace the Neutral reading with any sequence voltages or currents.

4.6.2 Show Ratio

Press the Show Ratio soft key to display the ratios of Va to Vc, Va to Ia and Ia to Ib. These measured components are fixed and no other ratios are available. Also, the data is only available on the display of the 933A, not available through the normal data stream from the 933A using PSCSV.

<table>
<thead>
<tr>
<th>Ratio</th>
<th>Magnitude</th>
<th>Phase</th>
</tr>
</thead>
<tbody>
<tr>
<td>Va/Vc</td>
<td>1.1995</td>
<td>-1.9708</td>
</tr>
<tr>
<td>Va/Ia</td>
<td>178.6823</td>
<td>0.1409</td>
</tr>
<tr>
<td>Ia/Ib</td>
<td>0.7385</td>
<td>1.8847</td>
</tr>
</tbody>
</table>

Figure 4.9: Show Ratio Display

4.6.3 Show Impedance

Press the Show Impedance soft key to switch from voltage and current to impedance - resistance (R) and reactance (X). Indicates the impedance of all configured phases and sequence components.

<table>
<thead>
<tr>
<th>Impedance</th>
<th>R</th>
<th>X</th>
</tr>
</thead>
<tbody>
<tr>
<td>PhA</td>
<td>106.1762</td>
<td>19.3128</td>
</tr>
<tr>
<td>PhB</td>
<td>110.2262</td>
<td>16.4622</td>
</tr>
<tr>
<td>PhC</td>
<td>103.7175</td>
<td>12.3491</td>
</tr>
<tr>
<td>Sn0</td>
<td>0.0000</td>
<td>0.0000</td>
</tr>
<tr>
<td>Sn1</td>
<td>0.0036</td>
<td>0.0094</td>
</tr>
<tr>
<td>Sn2</td>
<td>0.0007</td>
<td>0.0006</td>
</tr>
</tbody>
</table>

Figure 4.10: Show Impedance Display
4.7 Power Tabulation

Displays the Active, Reactive, Apparent and Q Results, as well as Power Factor, of power measurements for the configured system. Min–Max Results changes the soft keys to allow access to Normal, Minimum, Maximum and Average Results.

![Power Tabular Display](image)

Figure 4.11: Power Tabular Display

Press the EXIT Min–Max soft key to exit the Min–Max RESULTS menu and return to the Power Tabulation main menu.

4.7.1 Power Calculations

Power and Energy are determined by making twenty separate measurements per second with each measurement using 1024 samples (i.e. it takes data from a 100 millisecond window). This yields a 50% overlap for all readings to preserve accuracy. Therefore, since power is averaged over the interval, the displayed value may not exactly match what you would compute by multiplying the currents and voltages for each second.

For more detailed information on power calculations, see Appendix A: Model 933A Functional Description.
4.8 Power Quality

Displays two types of flicker; Instantaneous (One Second) and PST (10 minute). One-second flicker is displayed every second and PST continually indicates a 10 minute count-down timer with the result of the calculation in the same display. Press indicated soft key to switch between 1–Second and PST. Press Min–Max soft key to view minimum, maximum, average and normal values.

![Power Quality Display](image)

To select power quality:
1. Press the DISPLAY key and choose 5–Power Quality to select the One–Second Flicker results.
2. Press the Min–Max SELECTION soft key to open the NORMAL / MINIMUM / MAXIMUM / AVERAGE / RESTART of the power quality results.
3. Press RESTART Min–Max to restart tabulating power quality readings.

4.8.1 Min–Max

Press the Min–Max SELECTION soft key to open the Min–Max selection menu. For more information on using the Min–Max function, see Section 4.2.

![Min–Max Control](image)
4.8.2 Flicker Information

Flicker measurements deal with a fluctuation of the line voltage. It is a very specific problem related to human perception and incandescent light bulbs, but not a general term for voltage variations.

The basic concept behind placing limits on voltage fluctuations is that they cause lights to flicker, which can be irritating and may cause discomfort. Voltage fluctuations are caused by loads on the power distribution system, which are located near lighting equipment (within the same building or powered by the same distribution transformer), and have changing power or current levels.

Based on groups of people tested for irritation from light fluctuations, most tend to be irritated when the light fluctuates at around 1000 changes/minute. Apparently above 1800 changes/minute light flicker is no longer perceived. Fluctuations in the rms voltage of only 0.25% are sufficient to cause noticeable flicker in light bulbs.

The 933A measures flicker according to IEC 61000–4–15.

Definitions

Voltage Fluctuation: a series of voltage changes or a continuous variation of the rms voltage.

Flicker: Impression of unsteadiness of visual sensation induced by a light stimulus whose luminance or spectral distribution fluctuates with time.

One Second Flicker (or Instantaneous): is defined as the flicker measurement that is updated each second. The Model 933A displays this measurement.

Short-term flicker indicator, Pst: The flicker severity evaluated over a short period (10 minutes); Pst = 1.0 is the conventional threshold of irritability. A reasonable goal might be to limit Pst values to less than 1.0 for 95% of the time. The Model 933A displays this measurement.

Long-term flicker indicator, Plt: The flicker severity evaluated over a long period (over 2 hours) using successive Pst values. The Plt threshold is 0.8. The Model 933A does not display this measurement.
4.9 Energy Tabulation

Energy Tabulation makes all energy-related parameters accessible from one screen. This includes Watt-hours, VAR-hours, VA-hours, Q-hours and energy restart function (soft key on the far right).

![Figure 4.14: Energy Tabular Display](Image)

To select Energy Tabulations:

1. Press the DISPLAY key and choose 6–Energy Tabulation.

2. Press the specific soft key to view Wh, VAh, Qh and VARh RESULTS.

**Energy Restart** Press the ENERGY RESTART soft key to reset the energy totals to zero.
4.10 Phasor Display

Displays the voltage and current phasors for the configured system measured by the 933A. Screen includes tabular and vector data, soft keys for viewing the voltage phasors, current phasors or both. Display also includes instrument data including time, date and battery charge level.

For synchrophasors, using “Absolute” phase reference will cause the phasor display to rotate as the measured frequency differs from nominal. Selecting any other phase reference will cause that voltage or current phasor to appear in the zero-reference position (horizontal, pointed to the right).

To select Phasor Displays:

1. Press the DISPLAY key and choose 7-Phasor Display soft key to view the phasor display.
2. Press the VOLTAGE PHASORS soft key to view the graphical and tabulated results of the voltage phasors.
3. Press the CURRENT PHASORS soft key to view the graphical and tabulated results of the current phasors.
4. Press the V & C PHASORS soft key to view the graphical and tabulated results of the voltage and current phasors.
5. Press the Log key to record any data to flash memory.

Figure 4.15: Phasor Display

![Phasor Display Diagram]
4.11 Basic Data List

Basic Data List summarizes many measured and calculated values on one screen, including all configured voltages, currents, power and energy-related data and totals. Refinements include Energy Delivered, Basic plus Quality, Basic plus Sequence, Basic plus Phase and Min–Max Selection.

To select basic data list items:

1. Press DISPLAY > 8-Basic Data List.

2. Press any of the soft keys to choose the desired results with Basic Data. See screens below for individual information.

Figure 4.16: Basic Data Display
4.12 Config & Status

Press 9-CONFIG & STATUS to view configured electrical system, communication, time and date, calibration information, firmware versions by date. Also included is a battery and flash status screen that breaks down each category in more detail: Battery Status, Main Flash, Log Flash, Event Flash and DSP Flash. See screen shots below.

![Figure 4.17: Config and Status Display](image-url)
4.12.1 Status with GPS Synchronization

When selecting Config & Status with GPS connected for clock synchronization, a soft-key named SHOW GPS STATUS will appear. Press the SHOW GPS STATUS soft key to view GPS status information. Press the SHOW GPS STATUS soft key to display geographical position and satellite tracking information. Press the SHOW SATELLITES soft key to display the satellite positions and relative signal strength information.

![Figure 4.18: GPS Status Display](image-url)
Chapter 5

Reviewing 933A Data

Review event and data records stored in the Model 933A by pressing the REVIEW key and selecting the type of records you want to review. The main data-review screen is shown below.

![Main Review Screen](https://example.com/main-review-screen.png)

Figure 5.1: Main Review Screen

5.1 Review Data Selections

The following choices are available by pressing the appropriate soft key from the menu above:
5.1.1 Show Log Data
SHOW LOG refers to the 1-second data that is logged during a LOG key press, an Auto Log function, or from a Trigger (User, Power Quality, or from the optional Auxiliary I/O Module).

5.1.2 Show User Event Records
SHOW USER refers to the event record, including the exact time and date of the User programmed event. It does not refer to the data that may be stored before, during and after the event.

5.1.3 Show Power Quality Event Records
SHOW PWR QUAL refers to the event record, including the exact time and date of the power-quality event. It does not refer to the data that may be stored before, during and after the event.

5.1.4 Erase Log Data
Press the ERASE LOG DATA soft key to clear all the data from the flash memory card.

5.2 Steps to Locate & Review Records
Listed below are steps to assist you with identifying and locating the specific data you want to review. Basically, there are two types of records stored in the 933A: data records and event records. Decide which record type you wish to view; a record of the event, or the data recorded during the event?

5.2.1 Locating the Data Logged During an Event
To find actual data measured by the 933A, proceed as follows:

1. Press the keys, REVIEW > SHOW LOG > REVIEW SELECTIONS
2. Press the appropriate soft key that indicates the source of the data - Event Logs, Key Logs, Auto Logs or All Logs.

The following pages describe, in short steps and in more detail, how to view and download data from the 933A.
3. You can reduce or increase the rate at which you can search through records by pressing the REDUCE RATE or INCREASE RATE soft keys.

4. Press the numeric key that corresponds to the data record you wish to review.

5. Press the numeric key corresponding to the data type from the DISPLAY SELECTIONS screen to view the actual data record. Press any other numeric key to change the data type.

### 5.2.2 Locating Event Records

To find the event record information in the 933A, proceed as follows:

1. Press the keys, REVIEW > SHOW USER, or SHOW PWR QUAL

2. Press the REDUCE RATE or INCREASE RATE soft keys if necessary.

3. Press the numeric key that corresponds to the event record you wish to review. Notice that the event record always indicates the trigger by number and whether it is active (up arrow) or inactive (down arrow).

4. The next screen will always show the high-speed waveform record of the event, and within 50 ms of the event. Remember that there should be either 25 or 30 cycles of pre-event data.

### 5.2.3 Reviewing Recorded Data (Show Log)

To view any recorded data (following an Event or LOG key press, or Autolog session) press the keys:

REVIEW > SHOW LOG > REVIEW SELECTIONS > (EVENT LOGS, KEY LOGS, AUTO LOGS or ALL LOGS)

Press the soft key corresponding to the type of data you wish to review. This does two things: (1) it opens the specific data record selection window, and (2) returns you to the previous menu. From here you can review a record, choose other record types to review, press the REDUCE RATE or INCREASE RATE soft keys to improve record searches.

Figure 5.2 below shows how the 933A sorts the data records according to type. If you choose SHOW EVENT LOGS, only the Event records would
show up in the list. The “T” symbol on the right side of the individual record indicates that the data record is from a trigger.

Figure 5.2: Notice that 11 records show up in the list. “A” indicates Autologs, “K” indicates Key Logs and “T” indicates Trigger Logs. Compare the time and date of record number 0 with the time and date of Figure 5.4.

For view Trigger data, press the REVIEW key > SHOW LOG > REVIEW SELECTIONS > SHOW EVENT LOGS. Next to view data, press the record number (left side). You should see the DISPLAY SELECTION screen as in Figure 5.3 below.

Figure 5.3: Review Display Selection; appears the same as pressing the DISPLAY key, but during review it is in Hold Mode.

Press any of the number keys on the keypad to select the desired data type. Remember that the 933A stores a complete 1-second record of all measured data. The date and time of the data record in the list should agree with the date and time of the actual data record shown here – see Figure 5.4.
5.2.4 Review Selections Soft Key

Press the REVIEW SELECTIONS soft key to select the type of logged data you wish to view – Event Logs, Key Logs or Auto Logs.

- Show Event Logs – reveals only the recorded data from an event.
- Show Key Logs – reveals only the recorded data from a LOG key press.
- Show Auto Logs – reveals only the recorded data from an Auto Log.
- Show All Logs – reveals all three types of logged data.
- Exit Selections – returns to the previous screen (e.g. Review Selections).

Reduce Rate / Increase Rate

Use the REDUCE RATE or INCREASE RATE soft keys to adjust the scanning rate through the stored records. RATE keys will save time searching when the 933A has hundreds or thousands of records. The 933A indicates the search rate just above the soft key labels at the bottom of the display.
5.3 Reviewing User Event Records

In general, records are stored chronologically with the latest record at the top of the list. When viewing event records held in flash memory, the instrument is placed in Hold Mode, and you may access all recorded event data from the keypad. The User Event Record screen is described below.

Press REVIEW > SHOW User EVENT (soft key) to view the event records.

5.3.1 Interpreting a User Event Record

The data line in the small window (shown in Figure 5.5) indicates an event record. The values and symbols in the record indicate some things about the event.

- The event number, on the left of the display, includes the sequential number (0 – 9), the trigger number (01) and the arrow symbol. The arrow symbol signifies if the trigger is either active or inactive. An up arrow indicates an active trigger and a down arrow indicates an inactive trigger.

- Date & Time – date and time that the event occurred, including fractional seconds (in 50 ms increments).

- Type – Indicates the type of event record, User or Power Quality.

![Review User Event Data](image)

Figure 5.5: Review All Logged Records
5.3.2 Searching for Records

Use the soft keys and the right/left cursor keys to page and scroll through the records list. This is very useful when there are hundreds or thousands of records. Note that once moving, the search has inertia after lifting your finger off the cursor key.

Current Record Number

The current record is shown in the small window entitled Log Item: nnn..., where “nnn...” is the current record number. Press the right or left cursor arrows to step through the records. The vertical line in the window between “Oldest” and “Newest” indicates the position of the current record relative to the total number of records.

Total Log Items

The number of “Total Log Items” indicates the total number of records in the Log file. Flash storage capacity is approximately 16,000 records.

Reduce Rate / Increase Rate

If the total number of records is very large, press the rate adjust soft keys then to speed up the location of individual records.

To change the review rate, press the REDUCE RATE or INCREASE RATE soft key. The rate changes as follows: One Entry per Step, One Percent Steps, Five Percent Steps, Ten Percent Steps, Twenty Percent Steps.

The Record Number Indicator (vertical line) gives a visual clue to where the current list of records lies within the entire list of stored data.

To Return to Measurement Mode

To return to the Measurement Mode from Hold Mode (while reviewing event records), press Display key and choose a data type. The 933A will again begin displaying current measured data on the display.

To Review Recorded Data Again

Press the REVIEW key again to start over reviewing data.
5.3.3 Viewing Waveform Data at Time of Event

When viewing event records, the 933A can immediately reveal the high-speed waveform data recorded at the time of the event. Press REVIEW > SHOW USER > Event# (press the enter or number key corresponding to event record) to reveal the waveform record. See Figure 5.6.

1. To view other forms of data (e.g., per second data) press the numeric key related to the data form in Display Selection menu (as seen in Figure 5.7).

2. For example, press the “0” numeric key to view Tabular Results, or “2” to go back to waveform from previous view.

3. To view a specific data type, press any of the numeric keys according to the numbers shown in the Display Selection screen on the left in Figure 5.7.

Figure 5.6: Reviewing Records

Figure 5.7: Selecting Records
5.4 Reviewing Power Quality Event Data

The 933A treats Power Quality event records in much the same way as User event records, only it follows the rules of IEC 61000-4-30, paragraph 5.4, for Voltage Dips and Swells. When you select a specific event record (using either the ENTER or numeric keys) it will reveal the waveform at the time of the event.

1. Press the REVIEW key and select the SHOW PWR QUAL soft key. A list of any power-quality event records will appear in the display, if the 933A has captured any (see Figure 5.8, left screen).

2. Press the ENTER key, or any numeric key corresponding to the record number in the list, to view the waveform record at the time of the event (see Figure 5.8, right screen).

3. To access other power-quality event records, press REVIEW > SHOW PWR QUAL as in step 1.

![Figure 5.8: Selecting and Viewing Power Quality Records](image)

Notice that each data record provides a record number, trigger number, date and time of event, max and min values attained while the trigger was active. *Max and Min values are only produced after trigger becomes inactive.*

5.4.1 Viewing 1-Second Data Records

To view 1-second data logged at the time of the event (as viewed from Figure 5.8), press any of the numeric keys corresponding to the desired data type. Otherwise, you could press REVIEW > SHOW LOG > REVIEW SELECTIONS > SHOW EVENT LOGS. To use this effectively, you would need to know the time of the event to locate the record correctly.
5.5 Reviewing Data using PSCSV

To review 933A data using PSCSV software, you must first make a connection to the 933A. For information on making a connection between the 933A and PSCSV-933, go to Section 6.2.4 in PSCSV Basics.

To review data recorded in flash triggered by an event, click the Download Event button and a small window (see Figure 5.9) should appear with the following data types:

- DSP Log (User Event) – all User event records.
- Per Second – all one-second data recorded due to an event
- Sag Swell (Power Quality) Event – all Power Quality Event records.
- Waveform – waveform data recorded due to a power-quality event

![Figure 5.9: Download Event Screen – PSCSV](image)

NOTE: “User” and “Power Quality” include records of the event itself, not the data records collected at the time of the event. To download the actual data recorded at the time of the event, see Sections 5.5.2 and 5.5.4.

**Record Selection**

Record selection in Figure 5.10 allows you to choose either to Select All records or Select Range. Select Range allows you to limit the number of records you want to view by date and time.

![Figure 5.10: Selecting Events to Download – PSCSV 933](image)
5.5.1 User Event Record Example

Outlined below, is an example of downloading User Event records. Select USB for downloading waveform data, otherwise the download time could be very lengthy.

![Figure 5.11: Downloading User Records with Progress](image)

**Downloading Procedure**

Make sure that you are connected to the 933A. If not connected using PSCSV, see Section 6.2.4.

1. Begin by clicking the Download Event button to open the "Choose event data to download" window — see Figure 5.9. Select the DSP Log radio button, and click OK.

2. From the Data Selection window, choose either Select All or Select Range data by date and time — see Figure 5.10. If choosing Select Range, date and time values are in UTC format.

3. A SaveAs window should appear that allows you to save a record of the download. Click the Save button and the records should be transferred from the 933A to the computer.

4. When the User Log window appears, a progress window will indicate the progress of the record download graphically and by number of records — see Figure 5.11.

5. When the download is complete, select the line that indicates 933 DSP Log (User Event) with your cursor and click once. The previous window should immediately be minimized and a second SaveAs window should appear.
6. Click Save, or choose another filename and click Save, and a list of event records should appear as seen in Figure 5.12.

<table>
<thead>
<tr>
<th>PC Local Time</th>
<th>Trigger</th>
<th>Description</th>
</tr>
</thead>
</table>

Figure 5.12: Viewing Triggered Event Records – notice the trigger number and Trigger activity.

5.5.2 Per Second Data

Per–Second Data are the actual data recorded during an event. Click the Download Event button or select Connection > Flash > Download Event.

1. Choose the Per Second radio button and click OK.

2. Choose to select all data records or a smaller selection by time and date and click OK.

3. Choose a file name and click OK to save the file log. During this time a window will appear that shows both the progress and the record files being transferred from the 933A to a file on your computer. See Figure 5.13.

Figure 5.13: Downloading Per–Second Data

4. Now select the top line in the log with your cursor and a Save-As window will appear. Click OK, or type in a different name and click OK, and a window should appear with the data.
Notice that the spreadsheet of data types are organized by the tabs at the bottom of the window and fills to the right. See Figure 5.14.

The data window above contains normal one-second data including voltages, power, frequency and flicker. Select minimum and maximum values from the tabs below.

5.5.3 Power Quality Event Record Example

Make sure that you are connected to the 933A. If not, see Section 6.2.4 in PSCSV Basics. Click the Download Event button or select Connection > Flash > Download Event.

1. Choose the Sag Swell Event (Power Quality) radio button and click OK.

2. From the selection menu, choose to all data records or a smaller selection by time and date, and click OK.

3. In the SaveAs window, choose a file name and click OK to save the file log. During this time a window will appear (see Figure 5.15) that indicates both the progress and the record files being transferred from the 933A to a file on your computer.

4. Now select the top line in the log with your cursor and a Save-As window will appear. Type in a name (or accept the suggested file name), click OK and a window will appear with the data (see Figure 5.16).

5. Notice that each record begins with the time and date, followed by the trigger number, followed by a description of the event and finally the maximum and minimum values attained during the time the trigger was active.
5.5.4 Waveform Data

Recorded waveform data may be the result of User or Power Quality triggered events. Make sure that you are connected to the 933A. If not, see Section 6.2.4 in PSCSV Basics. Click the Download Event button or select Connection > Flash > Download Event.

1. Choose the Waveform radio button and click OK.

2. Choose to select all data records or a smaller selection by time and date and click OK.

3. Choose a file name and click OK to save the file log. During this time a window will appear that indicates both the progress and the record files being transferred from the 933A to a file on your computer.

4. Now select the top line in the log with your cursor and a Save-As window will appear. Type in a name, click OK and a window will appear with the data.

5. Notice that waveform record includes a cursor with the time and date at each point along the waveform, the corresponding voltage at the cursor, and the trigger number.
PSCSV933 provides trigger information the bottom of the waveform display, whether the trigger is active or inactive during the waveform recording. For example, if the triggering condition is false the display will indicate, "No triggers active". If a specific trigger is active, then it will indicate a message with the trigger number; for example if Trigger number two is active while the recording is going on, it will say, "User Triggers Active: 2". If more than one trigger is active, then all of them will be listed.

**Event Time Tracking.** See event waveform in Figure 5.18 below. Note that the actual event time appears below the dark vertical cursor in the middle of the waveform.

By carefully examining the waveforms, you will notice that there are “holes” in the waveform that correspond with different events. If two events are recorded at different times, then the waveform records will be connected piecewise, however there will be a discontinuity at the end of the first waveform record and start of the second waveform record.
Chapter 6

PSCSV Basics

6.1 Introduction

Power Sentinel CSV 933, or PSCSV, is the application software designed to operate with the Model 933A. This chapter was written to help you become familiar with how to use PSCSV to configure the 933A operation and manage data collected with the Model 933A.

6.1.1 PSCSV Features

- Analyze Power Quality: Harmonics, Flicker, K-factor and Interruptions
- Capture Events from 32 Configurable Triggers
- Log Data from Triggers – See Chapter 7
- Autolog based on Time and Date
- Synchronize with GPS or IRIG-B for Phasor Measurement
- Optional Event Inputs and Relay Contacts

6.1.2 Linking

The first step in using PSCSV with the Model 933A is by linking the 933A to a computer running PSCSV. To link them:

- connect the proper cable between the computer and the 933A
- open a connection to the 933A using PSCSV software
6.2 Windows, Menus and Toolbars

The PSCSV main screen (shown in Figure 6.1) provides access to its many features by assembling them together according to functional groups called Menus, Toolbars, Function Buttons and Windows.

**TIP:** When you first start PSCSV, only a few icons in the program will be available, but PSCSV will NOT be linked (having an open serial connection) to a specific Model 933A. You must click the Connection button or select Connection > Open to initiate a serial connection.

One function that is available when PSCSV is *not linked* to a Power Sentinel is viewing data files. You can open data files using the Open button without being connected to a 933A.

6.2.1 Main Window

![Figure 6.1: Main PSCSV Screen](image)

**Switching Toolbars ON or OFF**

To switch Toolbars on or off depending on the need and available space, select ‘View’ on the Main menu.

**Moving and Viewing Features**

You can move any Toolbar and dock it around the Main window by selecting and holding one of the Toolbar handles and dragging the Toolbar to a preferred location.
6.2.2 Menu Definitions

Most of the Menu selections are duplicated by the Toolbar buttons.

File Menu

The File menu > Open command allows you to open a 933A data file already saved on your computer. Use the Connection menu to open a connection between the 933A and a computer. Other File menu commands include, saving a snapshot (data capture while receiving a broadcast of data), exporting data in several protocols (see Section 6.4) and printing data.

Connection Menu

Most of the actual work is done from this menu. From opening a connection, to configuring the 933A, to collecting data, or to finally closing a connection, begin with the Connection menu or associated toolbar buttons.

Edit Menu

- **Copy.** copies the selected data to the clipboard.
- **Select All.** selects all of the data in the Data window.
- **Preferences.** selects window for setting various time and date viewing preferences. Select colors of signals in Waveform and Phasor views. Click the Edit menu to open. See Figure 6.2.

![Image of Edit Preferences window](image)

Figure 6.2: Edit Menu, Preferences
View Menu

Use the View menu to control the appearance of data streaming from the Model 933A. Items that can be controlled are described below.

- **Time Format:** format accompanying data in either GPS Local, UTC or PC Local time.
- **Filter Data:** selects and limits the data being viewed in the active PSCSV window.
- **Waveform Smoothing:** smooths the waveform appearance caused by the limited number of data points used to construct waveform.
- **Time Interval:** changes the time scale for waveform and phasor data – similar to an oscilloscope – to expand or compress the horizontal scale. Certain values are only available under preset viewing conditions.
- **Auto Scale:** Used by some functions to automatically scale data to fit in the window size.
- **View As:** view most data in real time or spreadsheet, harmonics also as vertical bars and phasors as a vector or frequency plot.
- **Toolbars:** switch on or off any combination of toolbars.

Window Menu

The Window menu helps you keep track of the open data channels and organize the data windows inside the main PSCSV window.

Help Menu

Help gives the PSCSV version information, connects you to the PSCSV page on the Arbiter website and can also pop up the Tip of the Day.
6.2.3 Toolbar and Button Definitions

Main Toolbar

Open: opens a specific 933A file (saved to a computer running PSCSV) – has browse features

Export CSV: exports selected 933A file records to .CSV for use in spreadsheet programs. Select either current data, or from data files.

Create a Snapshot: saves a sample of data being broadcast from the 933A, to a separate file for viewing.

Copy: copies selected records in a file under review in the PSCSV main window.

Home page: connects you to the PSCSV home page at:

www.arbiter.com/support/downloads

Connection Toolbar

Open a Connection: allows users to select a connection type, specify parameters and open a connection between the 933A and computer.

Close a Connection: immediately closes the current open connection (shown in the Connection Window) between the 933A and a computer.

User Login: PSCSV-933 does not use this feature; it is available for other Arbiter products. All 933A features are available with an open connection.

Connection Window: indicates the open connection(s) between the 933A and computer (See drop-down window in Connection Toolbar).

Broadcast Toolbar

Stop All: stops all broadcast data streaming from the 933A.

Stop This: stops the current broadcast data and leaves others alone.
Pause: pauses the flow of data from the 933A into the PSCSV data window. Broadcast data accumulates while paused.

Basic Data: initiates the flow of basic data into the main window.

Energy Data: initiates the flow of energy data into the main window.

Harmonic Data: initiates the flow of harmonic data into the main window.

Harmonic Summary Data: initiates the flow of harmonic summary data into the main window.

Waveform Data: initiates the flow of waveform data into the main window.

Phasor Data: initiates the flow of phasor data into the main window. Indicated as PMU-1.

Flash Toolbar

Flash Status: opens a summary window of flash memory status.

Erase Flash: erases all records held in flash memory.

Download Events: opens the Download Event window. Allows selection of records for downloading from flash memory.

Erase Events: not used in the Model 933A. Use the erase flash function.

Input Toolbar

Voltage Channels: selects voltage channel(s) when viewing waveform(s) or phasor data.

Current Channels: selects current channel(s) when viewing waveform(s) or phasor data.

Increase Vertical Scale: increases vertical scale resolution when viewing phasor data from Frequency Plot tab.
Decrease Vertical Scale: decreases vertical scale resolution when viewing phasor data from frequency plot tab.

Records Toolbar

Use the records toolbar to page through the data, especially when there are a large number of records.

Configure Toolbar

Configure toolbar buttons allow you to configure ports, configure measurement parameters and configure trigger parameters. Select the question mark to return the instrument status. Information on configuring ports and measurement parameters are located in this chapter. For complete details on configuring trigger parameters, see Chapter 7.

- Measurement Parameters: includes DSP mode, CT–PT Ratios, (transformer) Loss Compensation, Anti-Creep, Internal Calibration and Voltage Linearity. See Section 6.2.6
- Ports: includes RS-232 Port Settings and PMU-1 settings. See Section 6.2.5.
- Trigger Parameters: includes two distinct triggering methods: (1) User Triggers, and (2) Power Quality Triggers. See Chapter 7.
6.2.4 Connecting with the 933A

Two communication ports are available for remotely configuring the 933A, or for downloading the data to a computer. To link the 933A to a computer, you will need to: (1) connect the correct cable between the 933A and the computer, and (2) open a connection from the Connection window.

![Connection Window, RS-232 Selected](image)

**Figure 6.3: Connection Window, RS-232 Selected**

**RS-232 Port**

To open a connection between the 933A and a computer (refer to Figure 6.3):

1. Connect the included RS-232 cable (phone cord) and adapter (RJ11 to DB-9) between the 933A and the computer.

2. Press DISPLAY > 9 – Config & Status (look under the heading, COMMUNICATION) on the 933A to verify the communication port settings (especially Baud Rate).

3. Start PSCSV and click the Open a Connection button in PSCSV, or choose Connection > Open.

4. Click the plus sign, next to RS-232, to reveal the COM selections, which refer to the computer serial port. Choose the desired COM port and check to see if the port settings agree with that on the 933A.

5. Click OK and the Connection Window should show a connection; nine buttons should also become active on the Broadcast Toolbar. This shows that there is an RS-232 connection between the 933A and computer.
6. At this point, you have access to the instrument for configuring or downloading data. Go to the appropriate sections to perform these actions (e.g. see Section 6.3).

**USB Port**

1. Make sure that the 933 FTDI USB driver is installed on your pc. See Section 2.3.9 for further information on communicating via USB.

2. Connect the included USB cable between the 933A USB port and the computer USB port.

3. Start PSCSV and click the Open Connection button or select Connection > Open, and click on the “+” sign next to RS232.

4. Select the COM port number you set up with the FTDI Driver and click the OK button below (see Figure 6.3 above).

5. On some older 933A units, you may be able to connect via USB by selecting the “+” sign next to USB Devices, choosing USB 933 and clicking the OK button below.

**Ethernet**

The Model 933A does not have an Ethernet port and does not support Ethernet, however you may use an Ethernet-to-Serial converter to connect remotely to the 933A.

### 6.2.5 Configuring the 933A

Use PSCSV to remotely configure the various features of the Model 933A and accessory equipment. You can configure most features from front panel or all features by using PSCSV software.

**Configuring Ports**

Available settings in the Configure Ports menu include Communication Port 1 and PMU-1. All of the other items in the Configure Ports menu are not available. See Figure 6.4.

**RS-232, Communication Port 1**

Remember to use the USB port if you are going to configure Communication Port 1 settings. Otherwise, you will most likely lose your connection. For example, if you connect to Communications Port 1 at 38400 baud and
change the baud rate, the 933A will not respond. You will have to close
the connection and reconnect at the new baud rate.

The available settings are Baud Rate, Data Bits, Stop Bits and Parity.

![Configuring RS-232 Port](image)

**Figure 6.4: Configure RS-232 Port**

**PMU-1**

When dealing with phasor data, PSCSV is both a configuration and data
acquisition tool. It is designed to configure the 933A to produce *C37.118-
type* data. This means that while data is very similar to C37.118, *the
933A does not have an Ethernet port and is not C37.118 compliant*. See
Figure 6.5 to better identify the Phasor Terminology listed below.

**Phasor Terminology**

**Active** means that PMU-1 is poised and ready to send data — set to ON
if you want it to be active. Set to OFF if you want it to be inactive (or
unresponsive).

**Station** (or STN) is the station name, in 16 bytes in ASCII format, given
to the PMU. This field helps to identify the location of the equipment.

**ID** (or IDCODE) is the 16-bit integer, assigned by the user that uniquely
identifies the device sending and receiving messages (like the 933A).

**Header** contains additional information on any subject concerning the
PMU, of 64 bytes in ASCII format. Type in the information and press the
Enter key. This field could be used to identify the type of equipment.

**Input** allows you to select the type of signals you want to include in the
phasor report or broadcast. This includes all phase voltages and currents,
Figure 6.5: Configure Phasors, PMU–1

Positive Sequence, Negative Sequence, Zero Sequence components and Digital DSP Triggers. Turn them ON or OFF.

**Analog** allows you to select all of the power-related parameters (Watts, VARs, and VA) that you wish to activate.

**Window Length** sets the integer number of measurements averaged for stability; if you choose 1 for example, the values will update more quickly, however appear less stable; range of window length is from 1 to 24.

**Estimated Rate, Hz** is the integer number of phasor samples per second. Equals 25 sps for 50 Hz and 20 sps for 60 Hz.

**Cycles Used** is a calculated value based on multiplying the Estimated
Rate (R) times the number of cycles (or Window Length, W). Cycles Used = R × W. For example in the screen shot from Figure 6.5, this value is 20 × 10 = 200. Maximum values for Cycles Used are 1440 for 60 Hz and 1200 for 50 Hz.

**Data Format** allows you to set up the computation resolution and speed of which the 1133A processor can send data.

**Nominal Frequency** is either 50 Hz or 60 Hz, nominal.

**Adaptive Tuning** is used to help eliminate the possibility of losing the signal due to filter rolloff effects by continuously adjusting the receiver center frequency. Adaptive tuning is disabled if the error exceeds the limit. Set to ±2, ±5 or ±10 Hz.

**Estimator Algorithm** The 933A offers a wide range of window functions. All window functions serve the same purpose (as a low-pass filter) and work in the same manner. The main difference between windows is the magnitude of the ‘sideband lobes,’ which are peaks in the rejection band. Select a window function (Estimator Algorithm) based on desired performance. Test algorithm performance using WindowFunction.exe, the free software tool available on the Arbiter website. See http://www.arbiter.com/software/downloads.php

**Digital Channels** The 933A allows you to select any of the 32 available User (DSP) trigger records to accompany the regular phasor data. Select to report in either the normal or triggered state.

### 6.2.6 Configuring Measurement Parameters

Configure several measurement options by selecting Connection > Configure > Measurement Parameters or by clicking the Measurement Parameters button. You are not able to set “Internal Calibration,” and “Voltage Linearity” from PSCSV.

**DSP Mode**

DSP Mode includes setting the system frequency, input configuration, voltage range, current range, current auto range, and enabling Anticreep as seen in Figure 6.6.

**CTPT Ratios and Constants**

CTPT includes setting CT and PT nominal ratios, and twelve points for magnitude and phase error, and the calibration point for each.
Loss Compensation

Loss Compensation allows you to compensate for the iron and copper losses (real and imaginary) when connecting through a transformer. Compensate for transformer loss only through PSCSV, not through 933A front panel.

Anticreep

Anticreep sets a threshold below which the 1133A will not accumulate energy in the specific registers. This is similar to restricting an older style (electromechanical) meter from spinning when the energy value was below a certain threshold. Older electromechanical meters would spin due to the fact that they were merely energized and energy was not consumed by the user. Anticreep may only be configured from PSCSV software. First, set to “ON” in DSP Mode, then set Anticreep.

6.2.7 Other Windows

Save As

When selecting to broadcast any data, it will open with a Save As window. Since the data that you are broadcasting is ending up on your computer (monitoring the 933A measurements), it needs a file name. The SaveAs window provides a default file name. Choose this one, or you can type in another, and click OK.

Limit File Size

So that the data file does not take unlimited memory on your computer, the setting allows you to specify how much data you want to collect before
overwriting previously stored data. At the bottom of the Save As window is a check box with an associated size in megabytes.

**Filter Data Tool**

Select View > Filter Data to configure the types of data that will appear in any of the Broadcast Data screens. Filtering applies to both Summary and Spreadsheet views but must be selected separately. Filtering only limits what is being displayed in PSCSV, not what is saved in the file.

![Data Filter Tool](image)

**Figure 6.7: Data Filter Tool**

**One-Second Data**

Many of the Broadcast Data items (like voltage, current and frequency) are averaged values over a one second interval, providing more accurate measurements. For details on how the 933A computes these values, please see Appendix A, Functional Description.
6.3 Broadcast Data

6.3.1 Basic Data

Basic Data includes all of the configured input signals (voltages and currents - magnitude and phase), sequence components, frequency and frequency-related quantities, power-related quantities, and flicker. These values are computed as one-second data and a fresh measurement appears on the screen each second. Broadcast data can be synchronized to the GPS or IRIG-B and simultaneously saved in a file of choice.

Summary Data Screen

Summary view presents a graph in real time over a one-minute interval with the beginning and ending measurements and overall minimums and maximums. Fields include the named parameters, using the Filter Data tool.

Spreadsheet Data Screen

In spreadsheet format, tabular data includes times (UTC and Local), dates and one-second, measured parameters as filtered using the Filter Data tool.
6.3.2 Energy Data

Energy Data includes all energy-related qualities, including Watt-hours, Volt-Amp-hours, VAR-hours and Q-hours. These values are computed as one-second data and a fresh measurement appears on the screen each second.

To limit the number of items on the screen, use the Filter Data tool, which allows you to select only the items of interest. Note that filtering does not limit what is being stored in the data file; it only limits what is being displayed.

Summary Data Screen

Summary view presents a graph in real time over a one-minute interval with the beginning and ending measurements and overall minimums and maximums. Fields include the named parameters, using the Filter Data tool.

Spreadsheet Data Screen

In spreadsheet format, tabular data includes times (UTC and Local), dates and one-second, measured parameters as filtered using the Filter Data tool.
6.3.3 Harmonic Data

Harmonic Data includes all harmonic voltages and currents, magnitude and phase, from the fundamental to the fiftieth harmonic; that is 200 values for each phase. These values are computed as one-second data and a fresh measurement appears on the screen each second.

To limit the number of items on the screen, use the Filter Data tool, which allows you to select only the items of interest. Note that filtering does not limit what is being stored in the data file; it only limits what is being displayed.

Summary Data Screen

Summary view presents a graph in real time over a one-minute interval with the beginning and ending measurements and overall minimums and maximums. Fields include the named parameters, using the Filter Data tool.

Spreadsheet Data Screen

In spreadsheet format, tabular data includes times (UTC and Local), dates and one-second, measured parameters as filtered using the Filter Data tool.

Harmonic Bars include vertical bar graphs of the harmonic currents and voltages including the fundamental.
6.3.4 Harmonic Summary Data

Harmonic Summary Data includes RMS THD, RMS K, THD F, THD T and K Factor for all of the configured voltages and currents. All harmonic summary values are delivered to the open window.

Summary Data Screen

Summary view presents a graph in real time over a one-minute interval with the beginning and ending measurements and overall minimums and maximums. Fields include the named parameters, using the Filter Data tool.

Spreadsheet Data Screen

In spreadsheet format, tabular data includes times (UTC and Local), dates and one-second, measured parameters as filtered using the Filter Data tool.
6.3.5 Waveform Data

Waveform Data includes a number of cycles of all configured phase voltages and currents. Control the number of complete cycles using the View > Time Interval window control and choose a time interval value (from 50 ms to 5 seconds). A cursor allows you to pick out instantaneous voltages or currents.

To control the number of items on the screen, use the Input toolbar, which allows you to select only the voltage or current of interest. Note that filtering does not limit what is being stored in the data file; it only limits what is being displayed.

Waveform Data Screen

Graphical view displays current and voltage waveform data within a small time interval that is somewhat adjustable. Use the Input Toolbar to select only the voltage or current of interest.

Waveform samples are at 600 per second or approximately 10 per cycle at 60 Hz.
6.3.6 Phasor Data

Phasor Data includes all configured phase voltages and currents, frequency and sequence values. Data log times are also indicated in the display.

To control the number of items on the screen, use the Input toolbar, which allows you to select the voltage(s) or current(s) of interest. Note that filtering does not limit what is being stored in the data file; it only limits what is being displayed.

Displays

Two phasor views include a phasor with tabular data view and a frequency plot view. In the phasor data view, you can select to display the desired phase voltages or currents, and expand to view some tabular data.

For tabular phasor data, use the CSV button, or select File > Export CSV. The SaveAs window will appear and will prompt you to open the data in your spreadsheet application.
6.3.7 Lists of Broadcast Values

Data values available when selecting Basic Data from the Broadcast Toolbar are listed below.

**Basic Data – 55 Values**
1. A, B and C phase voltages and currents – magnitude and phase angle
3. Active Power (Watts) for A, B, C phases and Total.
4. Apparent Power (VA) for A, B, C phases and Total.
5. Reactive Power (VAR) for A, B, C phases and Total.
6. Power Factor (PF) for A, B, C phases and Total.
7. Q for A, B, C phases and Total.
8. System Frequency (Hz)
9. System Frequency Deviation
10. System Frequency Rate (df/dt)
11. System Time Deviation, Seconds
12. System Time Deviation, Cycles

**Energy Data – 40 Values**
1. Watt-Hours, Delivered and Received: A, B, C phases and Total
2. VAR-Hours, Q1 – Q4, A, B, C phases and Total
3. VA-Hours, Delivered and Received: A, B, C phases and Total.
4. Q-Hours, Delivered and Received: A, B, C phases and Total.

**Harmonics, Fundamental to the 50th – 600 Values**

**Harmonic Summary – 30 Values**
Includes RMS THD, RMS K, THD F, THD T and K-Factor for each voltage and current phase.

**Waveform Data – 6 Values**
Includes 3 phases for voltage and current.

**Phasor Data – 6 Values**
Includes 3 phases for voltage and current.
6.4 Data Conversions

6.4.1 Exporting COMTRADE Files

These instructions cover exporting COMTRADE files generated from waveform data captured by the Model 933A. During the exportation process, two COMTRADE files, a .dat and a .cfg file, are generated from waveform file and saved on the host pc.

Running PSCSV 933 Software, the opened waveform data is converted directly into these two files. The method used to capture waveform data in these instructions is by setting a voltage trigger to create a waveform record. The Model 933A automatically creates a waveform record when a configured 933A trigger becomes active (when the required event occurs). The specific trigger configured in these instructions initiates recording when the phase voltage exceeds a limit, and the 933A begins recording data to flash memory. This waveform record is then downloaded to the host pc. Once stored on the pc, the record is easily converted into two COMTRADE files. Without a captured waveform file there will be no information to convert to COMTRADE.

Basic Steps Required

1. Set up triggers in the 933A (using front panel or PSCSV).*
2. Connect signal wires.*
3. Erase previous logged data.
4. Instigate or wait for an event.
5. Download the event and waveform data (separately).
6. Export COMTRADE Files.

*Note: Order of these steps may be changed according to type of testing performed. For complete instructions on triggers, see Chapter 7.

Power Sentinel CSV Software version 1.129, dated April 2010, was used in creating these instructions.
6.4.2 Exporting to CSV Format

While you are reviewing any data downloaded from the 933A, you may choose to convert it to CSV format and review it on your spreadsheet.

In the session below, Per Second data is viewed after being downloaded. Notice that there should be a CSV button, also accessible by selecting File > Export CSV.

When you select either, a Save As window should appear with a suggested file name. Either click the OK button or type in a new file name and click OK.

A second window should appear and ask if you want to open your spreadsheet application with the data loaded. You can choose either Yes or No. If you select Yes, then the data converted to CSV format should appear in the spreadsheet (see Figure 6.9).

Note that the “Export CSV” feature works on any data that has been downloaded or is being broadcast from the 933A. Any data broadcast after you save the converted data will not appear in the file. If you want to include any later data in the same file, simply go through the Export CSV procedure again.
6.4.3 Exporting to PQDIF Format

While you are reviewing any data downloaded from the 933A, you may choose to convert it to PQDIF format.

In the session below, Figure 6.10 illustrates Per Second data being viewed after being downloaded. Export the selected data by selecting File > Export PQDIF.

A Save As window should appear with a suggested file name. Either click the OK button or type in a new file name and click OK.

Note that the “Export PQDIF” feature works on any broadcast data (except waveform or phasor) that has been downloaded or was broadcast from the 933A. Any data that was broadcast after you saved the converted data will not appear in the file. If you want to include any later data in the same file, simply go through the export CSV procedure again.

6.4.4 Save As Snapshot

Save As Snapshot creates a separate data file of all of the data recorded during a normal broadcast session up to the time that you create the snapshot file. Broadcast data will continue to fill the original broadcast data file. If you decide to create a later snapshot, the file will have all of the original data but with added data records determined by the interval number of seconds between the two snapshots created.
Chapter 7

Triggers and Event Recording

7.1 Introduction

Triggering is very useful for testing and troubleshooting electrical power systems. During the occurrence of an electrical event, the 933A can begin recording essential data for analysis. In this section we will look at how the Model 933A uses triggers to record data, and how to configure these triggers from both the 933A front panel and from PSCSV. For reviewing triggered events and logged data, see Chapter 5, Reviewing 933A Data.

7.1.1 Recording Data to 933A Flash Memory

When an event occurs the 933A will store a record of the event and begin recording all of the available electrical parameters into flash memory. The total number of records is based on the time interval configured under the LOGGING TIME screen, including in fault and post fault. Fault recording always includes at least one-half second of prefault data.

Data Recording Methods in the 933A

- pressing the LOG key
- using the Autolog feature
- configuring User Triggers
- configuring Power Quality Triggers
- using the External I/O Module
7.1.2 User Triggers

User triggers are general purpose in nature (compared to power quality triggers) and allow more flexibility. When active, a trigger signals the Model 933A to record data based on measured parameters, which are then processed by the Model 933A DSP. There are a total of 32 different triggers available that you can assign as either a User or Power Quality trigger.

7.1.3 Power Quality Triggers

Power quality triggers are set up in a manner very similar to User triggers, however they conform specifically to IEC 61000-4-30, Section 5.4, Supply Voltage Dips and Swells.

7.2 Setting a User Trigger

Follow the procedure in this section to configure a user trigger from the front panel. Remember that whenever you select a user trigger number, it is removed from the pool of 32 available triggers until turned off or reconfigured.

7.2.1 New Trigger

1. From any screen, press the SETUP key, then select 7- Trigger Setup from the number keypad. You should see a screen similar to that shown in Figure 7.1.

Figure 7.1: Initial Trigger Setup

2. Using the left/right cursor keys, choose a Trigger number (1 – 32); using the up/down cursor keys move the cursor to SELECT MODE, then use the left/right cursor keys to choose USER. Press
the ENTER key to open a screen entitled EDIT User TRIGGER (by number).

3. Choose the triggering parameters in this screen. Use a combination of the cursor keys, enter and numeric keys to enter the data. Normally, you will not need to press the Enter key each time you select a new field – use the up or down arrow to move between fields.

Definitions for the User Trigger values are found in Section 7.2.5.
7.2.2 Logging Time

4. Press the LOGGING TIME soft key to define the time period to log data when a trigger becomes active. There are two values to set: MaxLogTime and PostFault (time). MaxLogTime defines the number of seconds to record data during which the specific trigger is active (i.e. faulted). PostFault time defines the number of seconds that the 933A records data after the trigger becomes inactive (i.e. after the fault has disappeared).

![Figure 7.4: Configuring Data Logging Times](image)

5. Press the BACK soft key to return to the previous (Edit User Trigger) screen.

7.2.3 Back Soft key

6. Press the BACK soft key to return to the trigger summary screen and view any of the trigger settings by trigger number.

![Figure 7.5: User Trigger View](image)
7.2.4 SAVE SETTINGS Soft Key

7. Press the SAVE SETTINGS soft key to store any trigger changes. You may do this after setting up a number of triggers. Without pressing the Save Settings key, you will lose any configuration settings that you just made. It is always possible to return to TRIGGER SETUP to configure additional triggers as needed.

Dependency and Master Triggers

For more complicated triggering, where you would like to capture an event that depends on the occurrence of another event, use the Dependency option. For example, suppose that you wish to see the how frequency deviation is related to voltage sags. You could set up a frequency trigger that looks for a frequency deviation outside of a specified range. However, before you will allow the trigger, you must set up the dependency to another trigger that watches for a voltage sag. In this example, the voltage trigger would be called the Master, and the frequency trigger would be the dependent trigger.

Master triggers are subdivided into two groups: ActiveMaster and InactiveMaster. For Active Master, a dependent trigger could become active only after the master trigger became active. Conversely, for Inactive Master, a dependent trigger could become active when the Master trigger became inactive.

Dependency may also be set up in PCSV software. See Section 7.6.

7.2.5 User Trigger Parameter Definitions

**Input Signal:** Voltage, Current, Watts, VARS, VA, Power Factor (PF), Seq V Comp, Seq I Comp, Ph Bal Ratio, Freq & Time, THD Voltage, THD Current, Harmonic Vrms, Harmonic Irms, K-Factor V, K-Factor I, Flicker, Inst V, Flicker, Pst V, Flicker Inst I, Flicker, Pst I, Reserved(0 – 4), SchulzLaiosCh(1 – 6)

**Channel:** Select the phase of input signal, noted as A, C, B and Ave.

**Limit Ftn.:** (Limit Function) These are the logical conditions used to compare the Input Signal to the Limit; \( x > \text{limit} \), \( x < \text{limit} \), \( |x| > \text{limit} \), \( |x - \text{ref}| > \text{limit} \), where \( x \) is the measured signal.

**Limit:** a numerical value (floating point) to which \( x \) (the input signal) is compared.
Reference: Sets a numerical value (floating point) used with the Limit Type \(|x - \text{ref}| > \text{limit}\) for the value of ‘\text{ref}’. Can be used in a window comparison. For example, use \(|x - \text{ref}|\) to determine the frequency deviation, \(\delta f\). \(\delta f = |x - \text{ref}| = |59.995 - 60| = 0.005 H z\).

Dependency: Sets the condition of the Master Trigger as Off, Active-Master, Inactive-Master; “Off” turns off the Master Trigger feature; use the other two values to set up this trigger as a Master Trigger.

Master Trig: (Master Trigger) Assigns the specific Trigger number (1 – 32) as the Master Trigger, and upon which the current trigger is dependent. Set the Master Trigger prior to the dependent trigger for it to be available.

Wrt to Log: (Write to Log) Defines a period in seconds during which the triggering condition is true before it switches to Active. If set to zero, the triggering response time is immediate.

TriggerLog: ON or OFF; OFF means that when a trigger occurs, no event data will be recorded, but one-second data will be recorded, ON means that when a trigger occurs, an event record and data will be recorded.

MaxLogTime: MaxLogTime defines the amount of time in seconds that the 933A will record data while the triggering condition is true (i.e. the specific trigger is Active) – counts from 0 to 65535.

PostFault: Defines the amount of time in seconds that the 933A will log data after the triggering condition has disappeared (i.e. the specific trigger is Inactive) – counts from 0 to 65535.

7.3 Setting a Power Quality Trigger

Follow the procedure in this section to configure a power quality trigger. The set of 32 available triggers are shared between User triggers and power quality triggers.
7.3.1 Setting Up a New Trigger

1. From any screen, press the SETUP key, then select 7- Trigger Setup from the number keypad. You should see a screen similar to that in Figure 7.6, depending on whether the trigger is already configured, or OFF. Using the left/right cursor keys, choose a Trigger number.

![Figure 7.6: Power Quality Trigger Selection](image)

2. Using the up/down cursor keys move the cursor to SELECT MODE, then use the left/right cursor keys to choose PWR QUAL and press the Enter key. You should see a screen entitled EDIT PQ TRIGGER (by number) as in Figure 7.7.

![Figure 7.7: Selecting PQ Parameters](image)

3. This is the screen in which you configure most of your power quality settings. After you are finished with all of the settings in this screen, press the LOGGING TIME soft key to set the how long you want the 933A to log one-second data. See power quality parameter definitions in Section 7.3.2.
Edit PQ Trigger (#) – Category Screen

Choose a value for each category where applicable. Generally, you can select each category using the up/down cursor keys and select a value in that category using the left/right cursor keys. Numerical values (e.g. Limit) are entered directly from the numeric keypad.

7.3.2 Power Quality Trigger Parameter Definitions

**Channel**: AV, AI, CV, CI, BV, BI, NI - includes all of the input voltages and currents, including neutral. Set the Channel value to the input signal you want to compare to the Limit.

**Limit Ftn.**: (Limit Function) $x > \text{Limit}$, $x < \text{Limit}$; the first indicates a measured value greater than the limit, and the second indicates a measured value less than the limit.

**Limit**: Floating point value; constantly being compared to the input Channel value (x) in order to capture an event trigger. For example, Limit = 130 and $x > \text{Limit}$ would mean that a trigger would occur if the measured input voltage became greater than 130 Vrms (i.e. $x > 130$).

**Limit Mode**: Absolute or Percent; choose the limit mode that suits your application. For Absolute, the limit is the same number as the value entered in for Limit. For example, a Limit of 130 could generate an event trigger if the voltage swings above 130 Volts. For Percent, the measured value is compared to a percentage of the measured signal. Ten percent above nominal would be entered as 1.1.

**Ref. Mode**: (Reference Mode) choose either Absolute or Sliding. Absolute means that the reference value is fixed and compared directly. Sliding means that Reference value is not fixed (or absolute) and can change slowly, such as with a gradually rising or dropping voltage. See page 111.

**Hysteresis**: a floating point value; reduces extraneous records from accumulating when a measured value wavers around a limit or reference.

**Hyst. Mode**: (Hysteresis Mode) Absolute or Percent; absolute refers to a fixed value for hysteresis, and percent refers to a percentage of the measured value. As the measured value increases or decreases, so the hysteresis will change according to the given percentage of hysteresis.

**Multiphase**: B, C, BC or OFF; means that the trigger parameters can also apply to B phase, C phase or both B and C phase, without defining
another trigger.

**Dwell (half cycles):** Dwell, an integer, refers to the time in half cycles (at the nominal frequency) for the triggering condition to be true before which the trigger will become active.

**Hysteresis**

Hysteresis allows the user to set up some triggering conditions to reduce the tendency of a wavering signal (e.g. voltage) from generating unnecessary triggers. Figure 7.8 illustrates a voltage wavering around 130 Vrms, which is the set Limit for a trigger. To avoid unwanted triggers occurring at points A, B, C and D, a hysteresis value of 2 was chosen. This prevents a trigger from occurring unless the voltage drops at least 2 volts below the Trigger Limit. For the trigger to again become Active (i.e. after point E), Va would need to again cross the 130-Vrms Limit.

![Figure 7.8: Example of Hysteresis](image)

**Power Quality Reference**

For power quality triggers, install the Power Quality Reference values by pressing the PWR QUAL REFERENCE soft key seen in Figure 7.9. Figure 7.10 shows the power quality reference configuration screen. Use this to set the reference values. In this case, Reference refers to an initial, nominal voltage/current value, which is preloaded into the register for Sliding Reference voltages.

Press SETUP > 7 – Trigger Setup > Pwr Qual Reference soft key as seen in Figure 7.6. Install the values for any required reference. Press BACK to return to the Trigger menu. *Remember to press the SAVE SETTINGS soft key to retain any changes to these settings.*
Figure 7.9: Power Quality Reference Selection Softkey

Figure 7.10: Configuring the Power Quality Reference
Sliding Reference

Set the Reference Format to Sliding when you want to follow daily variations in voltage or current that do not require a trigger unless it exceeds the expected rate of change. For example, if due to usage requirements the line voltage sags during the day and swells during the night, you might want to use a sliding reference to avoid unnecessary triggers. A sliding reference would generate a trigger only if the voltage unexpectedly sags or swells at a rate greater than expected.

Calculating a Sliding Reference Voltage

Per the specification IEC61000-4-30, the sliding reference voltage is calculated by using equation 7.1; it is of first-order and uses a one-minute time constant.

\[(7.1) \quad U_{sr(n)} = 0.9967 \times U_{sr(n-1)} + 0.0033 \times U_{(10/12)\text{rms}}\]

Where

- \(U_{sr(n)}\) is the present value of the sliding reference voltage;
- \(U_{sr(n-1)}\) is the previous value of the sliding reference voltage; and
- \(U_{(10/12)}\) is the most recent 10/12-cycle r.m.s. value.

Note that even though the specification defines the input signal (U) as a voltage, it has been applied in the 933A to include measured input currents, as calculated using the same formula, with U as a current.

Logging Time

There are two available settings of which you can choose to control how the 933A logs one-second data when a trigger becomes active: MaxLogTime, and PostFault.

MaxLogTime: defines the number of seconds to record data during which the specific trigger is active (i.e. faulted). Setting MaxLogTime to 10 seconds will cause the 933A to record 10, once-per-second records after a trigger becomes active.

PostFault: defines the number of seconds that the 933A records data after the trigger becomes inactive (i.e. after the fault has disappeared).
Remember that if you have several triggers armed, any of them may be responsible for the 933A logging data if they become active.

7.4 Event Waveform Capture

7.4.1 Capture Method and Features

The Model 933A samples each of the six measurement channels at 10,240 samples per second at 16 bit resolution, and begins sampling when triggered from a specified event. Event recording always begins with one-half second of prefault data, so that you will always capture conditions in the 25 or 30 cycles of waveform data preceding the fault.

To capture this data the 933A has 128 MB of flash memory that is devoted entirely to waveform storage, and should be able to store sufficient data to analyze all channels. Thus, depending on the application, the 933A is able to capture inrush currents, sags and swells, transients and many other non-periodic phenomena.

7.4.2 High Speed Waveform Capture

The 933A begins recording data (including high-speed waveform) whenever a specified event trigger occurs. To assure that you capture the waveform anomalies you want, make sure to carefully configure the triggering conditions in the 933A.

![Figure 7.11: Reviewing Captured Waveforms](image)

When a specified event happens, the 933A will begin recording data in both flash modules for the time specified in LOGGING TIME setup screen. There are two items to configure in this screen: (1) Maximum Logging Time, and (2) Post Fault Time.
7.4.3 How Much Data do I Record?

It takes about 18 minutes to fill up 128 MB of waveform flash with the six input channels - three voltages and three currents. Decide how much waveform data you really need to record following an event. A few seconds of data is should be ample for each record, however the 128 MB allows for additional event recordings, providing the postfault data is kept short. For example, if each record includes one half second of prefault data and one second of post fault data (90 cycles), the 933A could provide approximately 720 fault records.

When selecting one of the event records by number, use the numeric keypad or enter key. The 933A will immediately open the waveform view at the time of the event and allow you to scroll forward and backward with the cursor keys to inspect the waveform. Use the right and left cursor keys to locate and examine specific points on the waveforms. Instantaneous values are computed where the cursor and the waveforms intersect and tabulated at the bottom of the screen.

Press the COMPRESS WAVEFORMS or EXPAND WAVEFORMS soft keys to view more or less of the captured event waveforms.

7.4.4 Event Capture Example

The waveform screen shown in Figure 7.12 is an example of an event caught through setting a power quality trigger on C-phase voltage. The voltage limit was set for 85 Volts rms, and trigger with \( x < \text{Limit} \). The 933A also caught a one-half second of the prefault waveform data, which is about 30 cycles.

![Figure 7.12: Captured Event Waveform](image)

By using the Expand or Compress soft keys and the right and left cursor keys you can review specific points of the event chronologically.
**Note:** The 933A records complete sets of one-second data around the occurrence of the event, depending on the set Logging Times. The 933A stores the main data records in the standard flash module, and stores high-speed waveform in another 128 MB flash module used exclusively for that purpose.

**Viewing One–Second Log Data**

1. Press REVIEW > SHOW LOG (soft key) to view a complete list of one-second log data. See Figure 7.13.

2. Press the REVIEW SELECTIONS soft key to separate all of the one-second log data into groups, and press the SHOW EVENT LOGS soft key

3. Look through the one-second data to find the time of occurrence of the event and press any of the number keys to select a data point.

4. Press any of the number keys to select the data type for viewing (e.g. 0-Tabular Results).

5. Press any of the soft key selections to choose to view any configured phase, or to view Min/Max information.

**Erasing Captured Waveform Data**

To erase any records stored in flash, press the REVIEW key, followed by the ERASE LOG soft key. You will be asked if you really want to erase all of the stored data in the flash memory modules. Select either the NO or YES soft key to proceed. *No partial data erasures are possible.*
7.5 Auxiliary I/O Module

Triggering with the Auxiliary I/O Module is very straightforward and is easy to set up. See Page 11 for accessory information.

7.5.1 Auxiliary I/O Module Description

The Auxiliary I/O Module has three contact outputs and four event inputs. One of the output contacts is a solid state set (KYZ-rated) and the other two are standard Form C mechanical contacts. The Event Inputs are separated into three groups: one set rated at between 24 to 240 Vdc, one set rated at TTL-level voltages (5 Vdc), and two sets are contact closure. Signals are connected to the module with ring terminals and connection to the Model 933A is by a nine-foot cable assembly.

The Auxiliary I/O Module is powered from the Model 933A and must be installed with the Model 933A powered OFF.

7.5.2 Configuring Event Inputs

1. Open the Auxiliary I/O connector cover on the 933A and slide in the plug on the end of the cable into the connector until it snaps in position.

2. Power on the 933A.

3. Press the SETUP key > 7 – Trigger Setup.

4. Press the EVENT SETTINGS soft key and choose the Event Input number with the right/left cursor keys.

5. Select the Mode (depends on the Event Input number), Max Logging Time (MaxLogTime) and Post Fault Time (PostFault).

6. Press the BACK soft key, and remember to Save Settings.

Terminology

In the Event Input Setup Window of the 933A are several terms: EventInput, Mode, MaxLogTime and PostFault.

EventInputs: 1 – 4
Mode: configures which input state triggers the 933A to begin recording; for voltage inputs: Active Hi or Active Lo; for contact inputs: Active Close or Active Open.

MaxLogTime: time the 933A will log data while the triggering conditions are active (i.e. that the triggering conditions are true).

PostFault: time the 933A will log data after the triggering conditions are inactive (i.e. that the triggering conditions are no longer true).

Checking the Event Inputs

To verify the event inputs, you can apply a correct voltage to event inputs 1 or 2, or use a short length of wire to short across the contacts of event inputs 3 or 4.

1. Press the SETUP key and 7 – Trigger Setup.
2. Press the Event Settings soft key to view the event screen (see Figure 7.15).
3. Connect the triggering signal to the desired event connection.
4. Watch the value in the line that states “EVENT INPUT STATE” change from 0 to 1 when the event occurs.
5. You can also watch the events stack up by pressing the Review key > Show Log. For each new event, you will see a number of records recorded based on the specified logging time.
7.5.3 Configuring Relays

The Auxiliary I/O Module has three relays; one solid state (KYZ) and two mechanical, Form C contacts. Relays 2 and 3 are useful for signaling by change of state from any one of 32 triggers.

Relay 1, KYZ-Rated Contacts

Relay 1 is a set of solid state contacts useful for keeping track of energy using the KYZ method. To set up these contacts, refer to Figure 7.16.

1. Select SETUP (key) > 7 - Trigger Setup > RELAY SETTINGS (soft key).

2. Specify the channel (A, B, C or Total), the type of signal (e.g. Watt-hour), and the scale (see below under Kp Register Scale Factor).

Kp Register Scale Factors

Correct scaling is necessary for accurate KYZ pulse metering. Enter in the value using the numerical keys on the front of the Model 933A keypad.
Scale factors are expressed in basic units (e.g. Watt Hours per Pulse) and should be set up not to exceed 20 pulses per second, the limit of the 933A. To arrive at the minimum scale factor value so not to exceed this threshold, take the maximum value of the basic unit being measured and divide by 72,000. This should give you the absolute limit (minimum value) for a scale factor.

For example, if the maximum input value (including CT-PT ratios) is 240 kWh, then the minimum scale factor for Watt Hours should be greater than 3.3333333 (240,000 ÷ 72,000 = 3.333...). The value produced is the Scale Factor (e.g. 3.3333 Wh per pulse). Scale Factors will be directly proportional to the value measured. Therefore, the greater the measured value, the greater will be the minimum Scale Factor.

**Over-Range Condition**: An over range input condition will exceed the 20/second output capability of the 933A, causing KYZ pulses to stabilize at that rate. If this is the case, for momentary periods, the accumulator in the 933A will store these counts not degrade the Model 933A accuracy. If data has accumulated in the 933A, then when the signal has dropped below 100% (by Scale Factor) the output will put out the additional pulses until the accumulated overage equals zero.

**Relays 2 and 3, Mechanical Contacts**

Relays 2 and 3 are two separate mechanical contact sets and each have a limited lifetime of about 100,000 cycles. Contacts are designed to change state based on the configured Trigger for each relay. For example, Relay 2, in the Figure 7.16, is set to trigger based on the state of Trigger 2. When the trigger limit condition is exceeded, then the trigger is considered Active and the relay will change state. When Trigger 2 changes back to the previous state, then the relay will revert to its previous state. Relay 3 is identical to Relay 2 and can be set up in the same manner as Relay 2.

As seen in Figure 7.17, Trigger 2 is responsible for activating Relay 2 when A-phase voltage drops below 85.0 Vrms. Notice that a hysteresis value of 2.00 was used to reduce the chatter from a signal on the measured channel fluctuating above and below the limit value.
7.5.4 General Relay Setup Procedure

1. Set up the Trigger (either User or Power Quality) on the 933A or by using PSCSV software.

2. Set up the desired relay by specifying the trigger in step 1, as seen in the RELAY SETUP screen in Figure 7.16.

![Figure 7.17: Relay-Trigger Reference](image)

7.6 Configuring Triggers with PSCSV

Use PSCSV for the 933 to configure both User and Power Quality Triggers. Configure both user and power quality triggers from the same location: Configure Trigger Parameters.

1. Open a connection between the Model 933A and your computer. For RS-232 and USB connections see Section 6.2.4.

2. Open the window by clicking the Configure Trigger Parameters button, or by selecting Connection > Configure > Trigger Parameters.

3. Once the Configure Triggers window is open, in the left panel select the type of trigger you want to use, either User or Power Quality.

4. There are 32 possible triggers you can set. For each one you intend to use, selecting any item that best defines what you are measuring.

5. See Sections 7.2.5 (User Triggers) and 7.3.2 (Power Quality Triggers) for definitions of the various parameters in the user triggers and power quality triggers configuration panel.
7.6.1 User Triggers

1. Select “Users Triggers” in the left panel of the Configure Trigger Parameters window.

2. Select an unused trigger (by number) by choosing the drop-down arrow under the column named “Input Signal” and adjacent to the desired trigger.

3. Begin choosing and filling in parameter values. Note that not all parameter fields are required (e.g. Reference & Dependency). See Section 7.2.5 for details on each parameter selection.

4. Indented from User Triggers are Schulz-Laicos settings. See Section 9.26 for more detail on Schulz-Laicos filters.

![User Trigger Setup using PSCSV](image)

Figure 7.18: User Trigger Setup using PSCSV
7.6.2 Power Quality Triggers

1. Click the Power Quality Triggers label in the left panel of the Configure Triggers window.

2. Select an unused trigger (by number) by choosing the drop-down arrow under the column named “Input Signal” and adjacent to the desired trigger. Input Signal value will indicate OFF if it is not selected.

3. Begin choosing and filling in parameter values. Note that all fields are required for Power Quality Triggers, however some field values may be “OFF” or “0”. See Section 7.3.2 for details.

4. Note that “References,” the values across the top of the individual trigger parameters, are the RMS voltage and current values you would expect under normal operation.

![Power Quality Trigger Detail](image)

Figure 7.19: Power Quality Trigger Detail

7.6.3 Auxiliary I/O Module

The Auxiliary I/O Module cannot be configured from PSCSV. Perform all event input and relay setup from the front panel of the Model 933A. See Section 7.5 for details.
Chapter 8

Specifications

8.1 Introduction

While the Model 933A directly measures voltages, currents and frequency, all other values — such as power and energy — are derived from these measurements and the internal clock. Flexible input connectors and instrument configuration allow you to connect to most common electrical systems. Optionally, a GPS module or IRIG-B signal may synchronize the internal clock to provide synchronized measurements. Possible input configurations and ranges are specified below.

8.2 Input Configurations

3 Phase (3P) 3-element, 2 $\frac{1}{2}$-element, 2-element
1 Phase (1P) 2-element, 1 $\frac{1}{2}$-element, 1-element

**Input Voltage**

Range (3P/1P) 1 — 650 Vrms, maximum — selectable (phase-to-phase for 2 element, phase-to-neutral for 2 $\frac{1}{2}$ and 3 element).

Overrange 700 Vrms, nominal, 1200 Vpeak
Input Current

Range (3P/1P)  1 – 20 Arms, maximum - per element
Low range    1 mA – 1 A
Overrange    23.5 Arms, nominal (maximum continuous input current: 20 Arms per element).

Volt-Amps, Watts, Volt-Amps-Reactance

Range       Product of rated voltage and current ranges and number of elements.

Compensating Constants and Ratios

CT and PT    Nominal ratios, magnitude and phase compensation, CT uses 12-point non-linear interpolation.
Transformer  Both iron and copper loss.

Input Frequency Range

Range       45 – 65 Hz, for specified accuracy.
Harmonics   3 kHz

Input Connector Ratings

Voltage      Safety Banana, color-coded per phase
Current      5-way binding post, including safety banana
Insulation   400 Volts, nominal, to neutral/chassis, surge voltage class III
             600 Volts, nominal, to neutral/chassis, surge voltage class II

8.3 Instrument Interface

Front Panel Indicators and Controls

Keyboard    30 keys, for status and configuration; including 5 soft function, 7 dedicated function, 5 cursor control, power on/off and 12-button numeric key pad
Display     Graphical LCD – 3 x 3.9 inches, 240 x 320 dpi, backlit
Communications
Serial RS-232C, RJ11 modular connector
USB Version 1.1, B-Type receptacle

Protocols
Proprietary PowerSentinelCSV (PSCSV)
Supported CSV, COMTRADE, PQDIF

Flash Memory Data Storage
Capacity 128 MB x 2, standard; 2 separate flash cards
Data Selectable from all functions measured and totalized by 933A; each record is stored with a time tag
Data Selectable
Data Retention Indefinite; no power or battery required to retain data
Storage Rate Selectable
Storage Rate Selectable
Lifetime 100,000 cycles

DSP Configuration
Configure Using PSCSV, configure DSP Mode, CT-PT ratios and transformer loss compensation. Internal calibration set at factory.
Unit Type Texas Instruments, TMS320C32 Floating-Point DSP
Configuration (Default) 120V, 5A, 60Hz, 3PH4W3EL; Other system configurations made through the front panel or PSCSV software.
Mode All structures initialized to know default settings (calibration values done after initialization).
8.4 Optional Auxiliary I/O Module

Connection between the Auxiliary I/O Module and the Model 933A is through dedicated cable on the Auxiliary I/O Module that connects to the Auxiliary I/O Connector on the Model 933A.

**Programmable Contacts**

<table>
<thead>
<tr>
<th>Type</th>
<th>2 each, Form C (SPDT)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connections</td>
<td>screw terminal</td>
</tr>
<tr>
<td>Rating</td>
<td>250 Vac/125 Vdc, 8 A maximum, 2000 VA/150 W maximum</td>
</tr>
<tr>
<td>Isolation</td>
<td>4000 Vrms for 1 minute to chassis</td>
</tr>
</tbody>
</table>

**Event Input Connections**

<table>
<thead>
<tr>
<th>Type and Number</th>
<th>Four, optically-isolated; one at 24 to 240 Vdc, one 5 V logic level, and two contact closure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Isolation</td>
<td>4000 Vrms for 1 minute to chassis</td>
</tr>
<tr>
<td>Resolution</td>
<td>1 μs</td>
</tr>
</tbody>
</table>

8.5 System Control and Monitoring

**System Time, Phase and Frequency**

<table>
<thead>
<tr>
<th>System Time</th>
<th>Unlimited accumulation with ±1μs resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency</td>
<td>7 digits, xx.xxxxx Hz</td>
</tr>
<tr>
<td>System Phase</td>
<td>0 to 360° with 0.01° resolution</td>
</tr>
</tbody>
</table>

8.6 Synchronization

**Optional IRIG-B Unmodulated Input**

TTL-Level Shift per IEEE 1344 as output from any Arbiter Systems clock model.
**Optional Remote GPS**

- **Tracking**: GPS-L1 (1575.42 MHz)
- **12 channel**: (tracks up to 12 satellites)
- **Acquisition**: 2 minutes typical
- **Accuracy**: UTC-USNO $\pm 1 \mu s$ (only 1 satellite with correct position needed)
- **Out-of-Lock Indication**: Via system interface and status display; optional, via contact closure.

**Timebase Error**

- **GPS locked**: Less than $\pm 1 \mu s$, when locked to at least one satellite with correct position
- **Unlocked**: 10 ppm, typical, after being locked to 10 minutes minimum ($< 1$ second/day unlocked, typical)
- **IRIG-B**: Less than $\pm 1 \mu s +$ accuracy of IRIG-B source

### 8.7 Measurement Specifications

**NOTE**: Accuracy specifications include all sources of uncertainty. Except as noted, specifications apply for the full operating range, including temperature (-10$^\circ$ to +50$^\circ$ C), line voltage, input range including specified over-range, power factor, input frequency, and drifts over a one-year calibration interval. Specifications assume synchronization to GPS and operation in 3-element mode or in a well-balanced system where imbalance does not degrade accuracy.

**Accuracy**

- **Watts, Wh**: 0.05% of reading, for voltage 7 to 650 Vrms and current 10 mA to 20 Arms and $PF > 0.2$
- **Underrange**: 0.005% multiplied by $(10 \text{ mA}/I \text{ rms})$ for current $< 10$ mA rms, typical
- **Vrms**: 0.05% of reading$^1$ or $\pm 5$ mV, whichever is greater
- **Arms**: 0.05% of reading$^1$ or $\pm 0.1$ mA, whichever is greater
- **Low range**: 1% of reading
Accuracy, continued

Phase Angle, $\phi$  
0.01°, phase-to-phase or voltage-to-current$^1$
Under range 0.05° (current 10 to 50 mA rms)

VA, VAh  
0.05% of reading$^1$
0.1% (current 10 to 50 mA rms)

VAR, VARh  
Same as W, Wh except replace PF with $\sqrt{1 - PF^2}$

Power Factor  
$0.0002 \times \sin(\phi)^1$

$0.001 \times \sin(\phi)$ (current 10 to 50 mA rms)

Harmonics  
0.1% THD or 5% of reading, whichever is greater

Frequency  
< 1 ppm (0.0001%) of reading, 50 or 60 Hz nominal, plus timebase error

System Phase  
$0.03^\circ + [\text{timebase error} \times 360^\circ \times \text{frequency}]^2$

System Time  
$1 \mu s + [\text{timebase error}]^2$

Event Inputs  
$\pm 10 \mu s$ (typical)

---

$^1$ For voltage 50 to 650 Vrms and current 50 mA to 20 Arms.
$^2$ With GPS option.

Phasors

Standard  
Per IEEE Standard 1344 or PSCSV

Rate  
20 Measurements/second

8.8 General

Physical

Size  
205 x 305 x 225 mm (8 x 12 x 8.8 in.)

Weight  
5.8 kg (12.8 lbs), maximum

Environment

Temperature  
-10° to + 50° C, Operating
-40° to +75° C, Nonoperating

Humidity  
Noncondensing
8.9 Power Requirements

Internal Battery

<table>
<thead>
<tr>
<th>Type</th>
<th>NiMH</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operation</td>
<td>8 hours, typical</td>
</tr>
<tr>
<td>Charging</td>
<td>4 hours</td>
</tr>
<tr>
<td>Standby</td>
<td>Use 5 VA, typical</td>
</tr>
</tbody>
</table>

External Power

| Range                   | 85 to 264 Vac, 47 to 63 Hz or 120 to 275 Vdc, 25 VA typical 5 VA typical stand by use |
| Input                  | IEC connector with fuse; surge withstand per ANSI C37-90.1 and IEC801-4 standard |
Chapter 9

Functional Description

9.1 Scope

Information in this section describes some of the components, functions and capabilities of the Model 933A.

9.2 Overview

The Arbiter Systems Model 933A Portable Power Sentinel consists of several blocks. They are: voltage and current inputs, and analog-to-digital converter; digital signal processor; host processor; display and keyboard; I/O functions; battery with charger, and power supply; IRIG (GPS optional) timing synchronization. The button features of the instrument and its measurement functions are described in the sections, which follow.

Two microprocessors are required to handle the many tasks being performed continuously in such a highly integrated portable instrument. A Texas Instruments TMS320C33 floating-point DSP unit performs the digital signal analysis tasks. Instrument I/O functions and interface to the “real world” are handled by an SGS-Thompson ST10F167 16-bit microcontroller. Both of these processors have significant additional processing power, which is not used in the initial version of the 933A. This will allow for the future expansion of features, which is sure to come, with a minimum amount of upset; indeed, many future enhancements should be possible with only a firmware upgrade.
9.3 Clock Synchronization

To provide accurate time synchronization for power measurements, the 933A can use either IRIG-B timing signal from a GPS clock, such as the Arbiter 1084A/B/C or 1093A/B/C or an optional twelve-channel global positioning system (GPS) receiver. Proprietary technology developed by Arbiter Systems and refined in several generations of GPS timing products also help to achieve accuracy. By comparing the internal 10-MHz crystal oscillator to the 1 PPS from an IRIG input or the output of a GPS receiver, the 933A can maintain its frequency at any time within a few parts in $10^{10}$, and time within one microsecond. All of the internal timing signals are derived from this accurate timebase. If no external timebase is provided, the 933A keeps time with an internal real-time clock.

9.4 Current Inputs

The current inputs of the 933A are implemented in a removable module. The standard current module is a three-phase, current input designed to be accurate to a few ppm over time and temperature (see “Error Analysis”). This current input section uses a two-stage process, similar to a two-stage current transformer except that the first stage, with active feedback is designed to cancel transformer errors and the second stage provides the current-to-voltage transfer. The current inputs have an accuracy of a few parts per million.

9.5 Voltage Inputs

The voltage inputs uses low-TC (temperature coefficient) voltage-divider resistor networks as signal attenuators. Voltage inputs may be configured as a three-phase, three-element input, with four connections (A, B, C, and N), or configured as a two-element input, with independent connections to each element (A+, A-, C+, and C-, for example).
9.6 Error Analysis

All identified sources of error in the 933A have been quantified using worst-case manufacturers’ performance data. These have then been combined using a root-sum-of-squares (RSS) method to yield a performance estimate. Effects due to initial calibration, measurement noise, temperature, and aging are all included. The reason for using RSS analysis is beyond the scope of this paper. However, we have found in our many years’ experience building calibration instruments that this method yields the most realistic estimate of actual worst-case performance, provided that numerous errors contribute significantly to the overall performance (i.e., no one error dominates), and provided that worst-case actual data is used for the analysis.

The error analysis, used for the 933A power or energy measurements, is shown in Table 9.1. Similar analyses have been performed for the other functions of the instrument, and include most of the same factors shown here.

<table>
<thead>
<tr>
<th>Temperature Errors, 0-50° C</th>
<th>Error, PPM</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current Input, resistor TCR</td>
<td>63</td>
</tr>
<tr>
<td>Voltage Input, resistor ratio</td>
<td>50</td>
</tr>
<tr>
<td>Voltage Reference (x2)</td>
<td>50</td>
</tr>
<tr>
<td>Cal. Source, resistor ratio (x2)</td>
<td>25</td>
</tr>
</tbody>
</table>

**Time Stability, 1 year**

| Current Input, resistor | 25 |
| Voltage Input, resistor ratio | < 20 |
| Voltage Reference (x2) | 36 |
| Cal. Source, resistor ratio (x2) | < 40 |

**Measurement Noise**

| 10 |

**Total RSS Error, Basic**

| 117 |

**Calibration Errors**

| Cal. Artifact, Rotek MSB-001A | 50 |
| Traceability to National Standards | 50 |

**Total Error, RSS**

| 136 |

**Specification (0.05%)**

| 500 |

Table 9.1: Power/Energy Error Analysis
9.7 Signal Sampling

Each of the signals, representing the scaled voltage and current inputs have their own ADC. Each signal is sampled simultaneously at a rate of 10,240 samples per second. If connected to an external timing source (e.g. GPS) it provides the sample clock to the 933A, it is synchronized to UTC-USNO (GPS), allowing measurements of phase angle across a power grid to be compared directly.

9.8 Power and Energy

Power and energy are determined by making twenty separate measurements per second of the cross product of voltage and current for each phase. Each measurement uses 1024 samples (i.e., it takes data from a 100 millisecond window), yielding a 50% overlap.

Apparent power (VA) and reactive power (VAR) are determined from the results of the voltage and current magnitude measurements (see next section), using standard identities. The active power measurements and reactive power measurements are then compensated for PT and CT corrections (see below) using a complex multiplication, and corrections are performed for transformer iron and copper losses, if enabled.

At this point, two different things are done with the resulting measurement data. First, a determination is made of the quadrant in which this data should be registered (Wh delivered or received, VARh delivered or received.) The results of each measurement cycle (20/sec) are then added to the proper set of registers. These registers are stored periodically, and accumulation restarted from zero. The user may configure the unit for different intervals to register energy.

The second thing that is done with the data is to determine the actual power level. This number will be displayed on the front panel (as watts or VARs), and it will be returned via the serial interface if a simple request for “power” is made. This result is calculated by averaging the 20 power measurements made during each second. Therefore, the update rate for this quantity is once per second. This data is not registered separately depending on the quadrant, as the energy data is; therefore, it is theoretically possible, if the direction of power flow changes periodically, that the sum of measurements reported over the serial interface may gradually depart from the registered energy data. This is due to the loss of information in the averaging process; the registered data are the most
accurate. The averaged data are provided primarily as a convenience or for system control purposes; it is not intended for billing purposes.

9.9 Voltage and Current

Voltage and current are measured in a similar fashion to power, using overlapping 1024-point measurements. In this case, however, the cross product is replaced with the square of the voltage or current samples. The square root of the resulting sum is proportional to the rms voltage or current value during the measurement interval. This value is corrected for the CT and/or PT correction factors before further use. The 933A uses the resulting data to correct the energy measurements, as described above. It also provides data to the host system by averaging it over one-second intervals.

9.10 CT and PT Compensation

To correct for the inaccuracies of the CT’s and PT’s used in the metering setup, CT and PT compensation may be enabled. Since the system voltage is relatively constant, the PT compensation factor is a single, complex (i.e., magnitude and phase, or real and imaginary) correction factor.

CT compensation is more complicated than PT compensation. Due to the fact that magnetizing currents in CT’s are not exactly proportional to the load current, a matrix is used. This allows the entry of several different compensation factors measured at different current levels. The 933A interpolates between the numbers in this table (also complex) to determine the correction factor to be used.

Correction for energy is performed using the (complex) product of the PT and CT factors. Correction for voltage or current is performed using the magnitude of the appropriate factor. Correction for phase angle is made using the phase of the appropriate component, i.e. the arctangent of the complex value. The actual calculation performed may be different than this description, due to computational considerations (a complex multiplication is far faster than a trigonometric operation such as an arctangent, for example); however, the end result will be as described.
9.11 Transformer Compensation

There are two different types of transformer compensation. They are used to correct for the losses in a transformer when primary-side metering is used to meter the energy delivered to a customer at the secondary of the transformer.

Copper compensation is used to correct for the $I^2R$ losses in the transformer windings due primarily to their (nonzero) resistance. As you would expect, this effect is primarily active (resistive), although there may be minor reactive effects, and it is proportional to the current squared. This factor allows the user to correct for these losses. It is a complex factor, providing both watts and VARs correction, and is proportional to current squared; i.e. so many watts and VARs are to be subtracted from the registered amounts per ampere squared of load current.

Iron losses (also called core losses) are due to magnetizing currents (the small amount of current required to generate the flux in the core, which is unrelated to the load current) and eddy current losses in the core material. These are approximately proportional to the square (watts) or 4th power (VARs) of the voltage, and the compensation is performed using the same basic method as described above for copper loss.

9.12 DC Offsets

DC offsets may be present in the signals applied to the input of the 933A, although this is unusual. More commonly, small dc errors in the measurement circuit result in nonzero average of the samples.

This potential source of error must be corrected to obtain maximum accuracy, since the 933A makes wideband measurements of power, voltage, and current. Components at any frequency within the measurement bandwidth, including dc, will affect the measurement. Therefore, part of the measurement process is to average the (windowed) data, measuring the dc component. The effects of dc offsets are then subtracted from the results.
9.13 Phase and Frequency

As a part of its measurement process, the 933A performs a fast Fourier transform (FFT) of the windowed voltage and current samples. In accordance with IEC 61000-4-7, this process is performed twenty times per second, using overlapping 1024-sample Hanning window data. This yields new FFT results twenty times per second for each voltage and current input, for a total of 120 FFT’s per second. Phase angle may be determined from the relationship between the real and imaginary component of the fundamental-frequency bin of the FFT. (Since the window is 100 ms wide, each bin is 10 Hz apart; therefore, this is bin 5 for 50 Hz and bin 6 for 60 Hz.)

So long as there is significant measured energy in the bin, frequency offsets do not affect the measured phase angle. This is true as long as the signal being measured is the main source of energy in the bin; i.e. there is minimal leakage from adjacent bins, and minimal noise. Provided that the frequency is anywhere near nominal (within 10 Hz or so), the phase measurement is perfectly usable.

The phase measurements may be compared to determine phase angle between voltages and currents or between any two voltages or currents. Because the sampling process may be synchronized via IRIG (GPS) to UTC, absolute phase angle measurements may be made and compared between two units located at some distance from one another.

Frequency is measured by taking the difference in phase angle between subsequent measurements, based on the identity $f = \frac{d\phi}{dt}$. Frequency is averaged over one second prior to being displayed or made available for output.

The 933A is the first product to make absolute (i.e. relative to UTC time) phase-angle measurements available in an economical unit which will be widely applied. Measurements of phase angle have been available before, but most products have not offered accurate time synchronization, and therefore most users are not experienced with the concept of absolute phase. When synchronized to either GPS or IRIG-B, all phase angles in the 933A are reported as absolute phase angles, relative to UTC (USNO) top-of-second. A phase angle of zero degrees is defined as corresponding to the positive maximum of a cosine wave being coincident with 1PPS-UTC(USNO). Relative phase angles, for example between phases, or between a voltage and a current, may be calculated by subtraction. Relative phases of harmonics may also be found by subtraction; however, the harmonic number prior to subtraction must multiply the fundamental,
absolute phase. This is because the subtraction is actually one of time; the purpose being to ‘realign’ the reference point to correspond to zero degrees on the fundamental. The phase angle corresponding to this time shift is proportional to the frequency.

9.14 Harmonics

Harmonics are measured using overlapping Hanning window FFT’s of 1024 samples and 100 ms window length. Based on the instantaneous frequency, the location of the bins containing significant energy for each harmonic are determined. This is a total of three bins, one approximately centered on the harmonic and those two adjacent to it. Then, the energy in those three bins is totaled, resulting in the energy for that harmonic. This can then easily be expressed as a percentage of the rms signal level, or in whatever form is required. While there is a closed-form correction, which can be employed to find the harmonic magnitude in the presence of frequency errors, this approximation was chosen because it is much faster and gives adequate performance.

There is an error in this approximation, due to the fact that there will be a small amount of energy leakage into nearby bins, which will not be included in the three measured bins. This is generally of little consequence when the frequency is close to being accurate (which is most of the time), since the amount of energy outside of the three bins summed is so low. Finally, with the Hanning window, there is no signal at all outside of these three bins if the frequency is exact. In the real world, however, the frequency will be off somewhat, and it is reasonable to ask how large the error can be. For small frequency errors, say 0.01 Hz, the 50th harmonic will be 0.5 Hz from the center of the nominal bin. This results in an error of about 0.005%, which is insignificant. The worst-case error will occur when a harmonic is very nearly centered between two bins. In this case, the algorithm described above will ‘miss’ a bin containing a signal with amplitude of about 17% of the actual harmonic amplitude. The energy contained in this bin is then \((0.17)^2\) or about 2.9% of the total energy, resulting in a measured energy 0.971x what it should be. The measured harmonic amplitude will then be \((0.971)^{0.5}\) or about -1.5% in error. This is well within the specification limits (5%) of IEC 61000-4-7. This worst-case error would occur for the 50th harmonic with a fundamental frequency error of 0.1 Hz. At lower harmonics, the frequency error must be progressively greater; for example, to result in a -1.5% error in measuring the 9th harmonic would require a fundamental frequency offset of 0.556 Hz. The phase angle of the harmonics is determined by
taking the arctangent of the real and imaginary components of the bin closest to each harmonic. This information cannot be used, however, in the averaging process described in IEC 61000-4-7, because this specification requires the rms average of a series of measurements. This, by definition, requires magnitude data only. Therefore, there are two different harmonic tables available from the unit. The averaged harmonic data, in accordance with IEC 61000-4-7, is provided in a 300-element array (6 channels x 50 harmonics), averaged over the interval specified by the user (typically 10 or 15 minutes). The harmonic magnitude and phase data are provided in a 600-element array, once per second. The harmonic magnitude is the rms value over the preceding second, and the phase angle is the ‘instantaneous,’ absolute (based on a 100 ms window centered at top of second) phase angle, as described in the preceding paragraph.

9.15 Flicker

Flicker is measured in accordance with IEC 61000-4-15, the successor standard to IEC 868. Unlike the other measurements described above, flicker measurement is a continuous process. This process is performed using a sample rate of 640 samples per second (sps). Anti-alias (decimation) filtering is performed on the 10240 sps data stream, and the resulting samples are further processed following the block diagram suggested in IEC 61000-4-15. The resulting measurements of flicker perceptibility are classified using a 256-level logarithmic classifier at the full 640 sps rate. Pst is then determined every ten minutes (or as specified), as described by the standards.

Although no standards currently require it, the 933A also measures flicker on the current inputs. This information can be useful in determining whether a customer’s load is causing flicker on the power system, or whether the customer is being subjected to flicker from other sources. It is unrealistic to penalize a utility for ‘poor power quality’ at a customer’s load when the cause of the problem is the load itself.

9.16 Interruptions

Interruptions are monitored on the voltage inputs by comparing the 20/second voltage measurements with a user-supplied threshold. Events are triggered when the voltage dips below the preset threshold. These can cause the logging of pre and post-fault data, contact closure, or any of the other actions described under “Event Logging.”
9.17 Voltage Fluctuations

Voltage fluctuations are monitored by classifying the 20/second voltage data, per phase, with a 256-step linear classifier covering a range of ±20% of nominal voltage. These data are then summarized as a cumulative probability table over a specified interval — typically 15 minutes. In addition, the minimum, maximum, mean and standard deviation are calculated. The data may be recorded in flash memory either continuously or on demand. Voltage fluctuations corresponding to system stability events may also be monitored and a trigger generated using Schulz-Laios filtering of the voltages.

9.18 System Time Deviation

System time deviation, which is the accumulated error of a clock using the system frequency as its reference, compared to an absolute reference such as UTC, is determined from the 20/second phase data described earlier. System time deviation is accumulated as integer cycles of error plus fractional phase, and is converted to seconds as needed. The positive-sequence voltage phase angle is used for this measurement. Since this is an integrated value, the constant of integration (initial time offset value) must be specified by the user.

9.19 Phasor Measurements

Phasor data are formatted and output in accordance with IEEE Standard 1344-1995. Phasors consist of the real and imaginary component of magnitude for the voltages and currents at a particular point in a power distribution system, along with suitable time synchronization fields and other information. This information is available in real time, and is based on the measured fundamental voltage, current, and phase angle described above, at a rate of 20 records per second. There is a measurement delay due to the data acquisition delay of 50 ms, signal processing time of approximately 15 ms, and data transfer time which depends on the data rate.

9.20 Phase Balance

The 933A measures phase balance by calculating the symmetrical sequence components (positive, negative, and zero sequence) for the three-phase
voltage input. Normally, if the unit is connected properly, the positive-sequence voltage will be equal to the line voltage and the negative- and zero-sequence voltages will be approximately zero. In the event that a user-specified limit on the imbalance (See “Triggering,” later in this section) is exceeded, an event will be recognized. In addition, the sequence components are averaged over a user-specified interval (typically 10 or 15 minutes) and may be logged if desired. These calculations are performed using the voltage magnitude and phase information, 20/second.

9.21 Load Balance

Load balance is calculated in much the same way as phase balance, except on the customer’s load current. The 933A uses both of these measurements to identify serious power system problems, such as a dropped phase, which could cause serious damage to the utility’s and the customer’s equipment.

9.22 Flash Memory and Event Logging

The 933A has two separate 128 megabyte flash memories for data and event logging. One memory is used exclusively for storing waveform data. The waveform data is stored for all input channels at the full data rate with 16 bit resolution. One half second of waveform data is continuously stored in RAM. Once an event designated to record waveform data occurs, this data is transferred to Flash and waveform data continues to be stored according to user defined times and conditions. About 10 minutes of waveform data may be stored.

The other Flash memory may be used to record three basic types of information: (1) registered quantities, (2) event data, and (3) system status events. Registered quantities are recorded on a fixed schedule and may include many more items than a typical energy meter, including just about any function the instrument can measure. The event data are logged on the occurrence of an event designated to initiate logging. System status is used for advanced monitoring and control of the operation of the 933A and the system node to which it is connected.

Events are defined as any measured quantity exceeding a user-specified threshold, an external trigger, or an internal state of the 933A (low flash memory, for example).

There is a great deal of flexibility as to what may be recorded in flash memory at the time an event is recognized. Recorded information may
any of the following:

- Time of event
- Type of event
- State of measured quantities
- Pre and post-event data
- Any of the measured quantities - e.g. voltage, power, waveform, etc.

The 933A must be configured in advance to specify the events being recognized and actions to be taken.

To maximize usage of flash memory, it is important to distinguish registered quantities from event log data. The amount of memory needed to record a certain number of registered items for a certain period can be determined exactly, whereas the amount of memory required to log events depends on the number and type of events, and the number of items to be recorded for each type. Since the number and type of events cannot be known a priori, the amount of memory required also cannot be stated with certainty. The 933A handles this by allocating sufficient memory as required for the registered quantities over the specified period of time, and then making whatever memory is left available for event logging. To deal with low register or event memory conditions, the 933A can be configured to initiate an auto-dial call or contact closure when the condition is met.

Two separate 128 MByte flash cards are allocated 1024 blocks each for a total of 256 MBytes and purposed for different applications. Flash memory must be erased in blocks, and data cannot be overwritten until its block is completely erased. Therefore, the normal process will be to first read out the desired data, and then erase the blocks, making them available for reuse. Erase memory from the 933A front panel or through PSCSV software. It is erased all at once; no partial erasures are possible.

### 9.23 Optional Contacts & Event Inputs

Four contact outputs may be used to report events recognized by the 933A. In addition to reporting events, these contacts may be used to synchronize external equipment or to operate load-control switch gear. See Section 7.5.

Four external optically-isolated event inputs are also provided and come in three groups: (1) one accepts dc signals at levels from 24 to 240 volts, (2) one at CMOS/TTL (5V) levels, and (3) two sets are contact closure. Application of a signal to one of these inputs will be time-tagged to one microsecond resolution. See Section 7.5 for setup information.
9.24 Serial Channels

The two standard serial channels are RS-232 and USB. Each channel has access to most functions of the 933A (excluding autolog and programming Auxiliary I/O module). The RS-232 channel has a RJ11 (6-position) modular connector useful for connecting with a standard phone cable. Use a RJ11 to DB-9F adapter at the end of the phone cable to connect the 933A to a computer. These adapters may be rewired in the field to match interface requirements. Both serial channels may be operated simultaneously, each serving different hosts with separate access authorization and information channels.

9.25 Triggering in the Model 933A

The digital signal processor (DSP) in the 933A Power Sentinel measures dozens of different parameters of the applied input signals, in many cases at a rate of 20 measurements per second. Most of these parameters may be used to trigger an alarm condition, based on preset thresholds and conditions.

Triggering in the DSP works as follows. First, there are 31 different measurement types that may be selected for processing by the trigger algorithm (Table 2). For each of these, there are (typically) four different measurement channels, A, C, B and either average, total, or maximum (of A, C, and B). Thus, there are a total of 124 different signals (corresponding to individual measurement results) which can be selected. Not all of these are defined at this time, however.

Second, there are 32 trigger channels, which may be configured for use concurrently (Table 3). Each of these may be set to use any of the 124 signals as their input. For each channel, there is a limit, which may be set by the user, as well as a reference value, which may be used by the trigger logic. The limit function logic may be set to any of four modes: $x > \text{limit}$; $x < \text{limit}$; $|x| > \text{limit}$; or $|x - \text{ref}| > \text{limit}$. In addition, each trigger channel may be made dependent on the results of another channel. It may be set so that the channel requires the other trigger to be either active or inactive before proceeding with its own comparison. Comparisons are made at the 20 per second rate for all channels, even for input signals, which change more slowly.

Each channel also has a dwell time, or delay time, register. Before it will generate a trigger, the specified signal must exceed its limit condition for a number of comparisons equal to this register (plus one). The register
is a 16-bit unsigned integer, having a range of 0 to 65535 cycles. Since comparisons are performed 20 times per second, this corresponds to a range of dwell time of 0 to 3276.75 seconds. A value of 0 allows the trigger to be recognized at any time the corresponding condition is true; a value of 1 (0.05 seconds) requires the trigger condition to persist for two consecutive comparisons, and so on.

Considering all of the different input signal possibilities, along with the different limit modes and inter-channel dependencies, there are an almost limitless number of possible combinations of settings for each trigger channel.

9.26 Detecting Oscillatory Transients and Other Anomalies

Special logic is included in the 933A to implement the algorithms described by Schulz and Laios [1], which are designed to detect power system anomalies such as oscillatory transients. There are six channels dedicated to performing this function in the 933A (Table 4). Each of these may have any of the 124 signals described above as its input. Each channel has three outputs: a low-pass-filtered (‘bound’) output, a rate-of-change output, and an oscillation-detector output. Each channel also has three control parameters (in addition to the input signal selection): the rate-of-change filter time constant (T1 in [1]); the oscillation-detector time constant (T2 in [1]); and the oscillation-detector reset threshold, also described in [1]. These parameters control only the operation of these signal-processing blocks, and do not in themselves generate any triggers. To generate triggers, select one of the three outputs of one of the channels in this block. This serves as an input to one of the 32 trigger channels. As recommended by Schulz and Laios, the input filtering for this block is the BPA #1 low-pass, described in [2], which is a 12-point Hanning-weighted FIR low-pass filter having a group delay of 0.3 seconds at a 20/second sampling rate.
Table 9.2: Signal Functions Available for Triggering

<table>
<thead>
<tr>
<th>ID#</th>
<th>Function</th>
<th>Rate</th>
<th>Channels Available</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Off</td>
<td>20/sec</td>
<td>N/A</td>
</tr>
<tr>
<td>1</td>
<td>Voltage</td>
<td>20/sec</td>
<td>A,B,C, Ave.¹</td>
</tr>
<tr>
<td>2</td>
<td>Current</td>
<td>20/sec</td>
<td>A,B,C, Ave.²</td>
</tr>
<tr>
<td>3</td>
<td>Active Power (Watts)</td>
<td>20/sec</td>
<td>A,B,C, Total³</td>
</tr>
<tr>
<td>4</td>
<td>Relative Power (VARs)</td>
<td>20/sec</td>
<td>A,B,C, Total³</td>
</tr>
<tr>
<td>5</td>
<td>Apparent Power</td>
<td>20/sec</td>
<td>A,B,C, Total³</td>
</tr>
<tr>
<td>6</td>
<td>Power Factor (PF)</td>
<td>20/sec</td>
<td>A,B,C, Total³</td>
</tr>
<tr>
<td>7</td>
<td>Sequence Voltage</td>
<td>20/sec</td>
<td>Zero, Pos., Neg.</td>
</tr>
<tr>
<td>8</td>
<td>Sequence Current Components</td>
<td>20/sec</td>
<td>Zero, Pos., Neg.</td>
</tr>
<tr>
<td>9</td>
<td>Phase Bal. Ratio, Derived from sequence components</td>
<td>20/sec</td>
<td>Zero, Pos., Neg.</td>
</tr>
<tr>
<td>10</td>
<td>Frequency and Time</td>
<td>20/sec</td>
<td>Freq., DF, df/dt, DT</td>
</tr>
<tr>
<td>11</td>
<td>THD Voltage</td>
<td>1/sec</td>
<td>A,C,B, max (A,C,B)¹</td>
</tr>
<tr>
<td>12</td>
<td>THD Current</td>
<td>1/sec</td>
<td>A,C,B, max (A,C,B)²</td>
</tr>
<tr>
<td>13</td>
<td>Harmonic $V_{RMS}$</td>
<td>1/sec</td>
<td>A,C,B, max (A,C,B)$¹$</td>
</tr>
<tr>
<td>14</td>
<td>Harmonic $I_{RMS}$</td>
<td>1/sec</td>
<td>A,C,B, max (A,C,B)$²$</td>
</tr>
<tr>
<td>15</td>
<td>K-Factor, voltage</td>
<td>1/sec</td>
<td>A,C,B, max (A,C,B)$¹$</td>
</tr>
<tr>
<td>16</td>
<td>K-Factor, current</td>
<td>1/sec</td>
<td>A,C,B, max (A,C,B)$²$</td>
</tr>
<tr>
<td>17</td>
<td>Flicker, instantaneous, voltage</td>
<td>1/sec</td>
<td>A,C,B, max (A,C,B)$¹$</td>
</tr>
<tr>
<td>18</td>
<td>Flicker, PST, voltage</td>
<td>1/sec</td>
<td>A,C,B, max (A,C,B)$¹$</td>
</tr>
<tr>
<td>19</td>
<td>Flicker, instantaneous current</td>
<td>1/sec</td>
<td>A,C,B, max (A,C,B)$²$</td>
</tr>
<tr>
<td>20</td>
<td>Flicker, PST, current</td>
<td>1/sec</td>
<td>A,C,B, max (A,C,B)$²$</td>
</tr>
<tr>
<td>21-25 Reserved</td>
<td>TBD</td>
<td>TBD</td>
<td></td>
</tr>
<tr>
<td>26-31 Transient Detector, channel 0-5</td>
<td>20/sec</td>
<td>Bound, rate/ch., osc.</td>
<td></td>
</tr>
</tbody>
</table>

¹. Average or maximum of 3 voltage channels in 3P4W3E and 3P3W2E input mode, 1 channel in 1P2W1E mode, and 2 channels in other modes. In 3P3W2E mode, the voltage VAC is derived internally by point-by-point calculation after A/D conversion. The voltage VB, synthesized internally in 3P4W21/2E mode, does not correspond to an actual physical quantity and is not included in the analysis, although measurements can be made on the synthesized signal.

². Average or maximum of 3 current channels in 3-phase modes, 1 channel in 1P2W3E mode, and 2 channels in other modes. In 3P3W2E mode, the current Ib is derived internally by point-by-point calculation after A/D conversion.

³. Total of 3 elements in 3P4W3E and 3P4W21/2E modes, 1 element in 1P2W1E mode, and 2 elements in other modes.
Table 9.3: Trigger Channel Parameter Summary (32 Channel)

<table>
<thead>
<tr>
<th>Function</th>
<th>Range or Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input Signal</td>
<td>1-31, per Table A.2 above (set to 0 if not used)</td>
</tr>
<tr>
<td>Channel</td>
<td>0-3, per right column in table above</td>
</tr>
<tr>
<td>Trigger Dependency</td>
<td>0-2, Off, Active, Inactive</td>
</tr>
<tr>
<td>Master Channel</td>
<td>0-31, any other trigger channel</td>
</tr>
<tr>
<td>Limit Type</td>
<td>0-3; $x &gt; \text{limit}$, $x &lt; \text{limit}$, $</td>
</tr>
<tr>
<td>Dwell (delay) time</td>
<td>0-65535, 50 ms/count; 0 to 3276.5 seconds</td>
</tr>
<tr>
<td>Limit Value</td>
<td>Floating Pt, in measurement units (volts, watts, . . .)</td>
</tr>
<tr>
<td>Reference Value</td>
<td>Floating Pt, in measurement units (volts, watts, . . .)</td>
</tr>
</tbody>
</table>

Table 9.4: Schulz-Laios Transient Detector Algorithm Control (6 Channel)[1]

<table>
<thead>
<tr>
<th>Function</th>
<th>Range or Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>T1</td>
<td>High-pass (rate detector) time constant, seconds Minimum 0.05 seconds, typical 0.5 seconds</td>
</tr>
<tr>
<td>T2</td>
<td>Oscillatory detector low-pass time constant, seconds Minimum 0.05 seconds, typical 5.0 seconds</td>
</tr>
<tr>
<td>Oscillatory detector</td>
<td>Threshold in measurement units. Set to any negative number to disable reset</td>
</tr>
<tr>
<td>Reset threshold</td>
<td></td>
</tr>
<tr>
<td>Input Signal</td>
<td>0-31, per Table A.2</td>
</tr>
<tr>
<td>Channel</td>
<td>0-3, per right column in Table A.2</td>
</tr>
</tbody>
</table>


Figure 10.1: 1-Phase, 2-Wire, 1-Element – Direct Connection
Figure 10.2: 1-Phase, 2-Wire, 1-1/2-Element – Direct Connection
Figure 10.3: 1-Phase, 3-Wire, 2-Element Direct Connection
10.4 3P3W2E Delta – Direct Connection

Figure 10.4: 3-Phase, 3-Wire, 2-Element, Delta – Direct Connection
Figure 10.5: 3–Phase, 4–Wire, 2.5-Element Direct Connection
Figure 10.6: 3–Phase, 4–Wire, 3–Element Connection
Figure 10.7: 1–Phase, 2–Wire, 1–Element, Using CT/PT Connection
Figure 10.8: 1–Phase, 2–Wire, 1 1/2–Element, Using CT/PT Connection
Figure 10.9: 1-Phase, 3-Wire, 2-Element, Using CT/PT Connection
Figure 10.10: 3-Phase, 3-Wire, 2-Element Delta, Using CT/PT Connection
Figure 10.11: 3-Phase, 4-Wire, 2 1/2-Element, Using CT/PT Connection
Figure 10.12: 3-Phase, 4-Wire, 3-Element, Using CT/PT Connection
Appendix A

Glossary

A.1 DHCP

Dynamic Host Configuration Protocol (DHCP) is a communications protocol that lets network administrators manage centrally and automate the assignment of Internet Protocol (IP) addresses in an organization’s network. Using the Internet Protocol, each machine that can connect to the Internet needs a unique IP address. When an organization sets up its computer users with a connection to the Internet, an IP address must be assigned to each machine. Without DHCP, the IP address must be entered manually at each computer and, if computers move to another location in another part of the network, a new IP address must be entered. DHCP lets a network administrator supervise and distribute IP addresses from a central point and automatically sends a new IP address when a computer is plugged into a different place in the network.

A.2 DNS

A Domain Name Server (DNS) is used to map names to IP addresses and vice versa. Domain Name Servers maintain central lists of domain name/IP addresses and map the domain names in your Internet requests to other servers on the Internet until the specified web site is found.
A.3 DSP

Digital Signal Processing: DSP refers the hardware (DSP microcontroller and associated components) and firmware (the programming code running the microcontroller) that process the input signals and calculate the required output data.

A.4 Ethernet

Ethernet is the most widely-installed local area network (LAN) technology. Specified in a standard, IEEE 802.3, Ethernet was originally developed by Xerox and then developed further by Xerox, DEC, and Intel. An Ethernet LAN typically uses coaxial cable or special grades of twisted pair wires. Ethernet is also used in wireless LAN’s. The most commonly installed Ethernet systems are called 10BASE-T and provide transmission speeds up to 10 Mbps. Connected devices compete for access using a Carrier Sense Multiple Access with Collision Detection (CSMA/CD) protocol.

A.5 Fast Ethernet

Fast Ethernet or 100BASE-T provides transmission speeds up to 100 megabits per second and is typically used for LAN backbone systems, supporting workstations with 10BASE-T cards. Gigabit Ethernet provides an even higher level of backbone support at 1000 megabits per second (1 gigabit or 1 billion bits per second). 10-GB Ethernet provides up to 10 billion bits per second.

A.6 Flash

Nonvolatile memory used for storing programs and data. In the Model 933A, this term primarily refers to the 128-MB memory devices used for data storage.
A.7 K Factor

K–Factor is a weighting of the harmonic load currents according to their effects on transformer heating, as derived from ANSI/IEEE C57.110. A K–Factor of 1.0 indicates a linear load (no harmonics). The higher the K–Factor, the greater the harmonic heating effects. It is calculated based on the following equation:

\[
K_{Factor} = \frac{(V_1 \times 1)^2 + \cdots + (V_{50} \times 50)^2}{V_1^2 + \cdots + V_{50}^2}
\]

where each component is multiplied by the harmonic number (e.g. 1, 2, \cdots, 50), called a weighting factor.

Harmonic load currents significantly affect power distribution system design. Harmonics create additional losses through the skin effect at high frequencies and through higher RMS load currents. By specifying K-Rated transformers and using other techniques, power distribution systems and customer equipment should have lower failure rate.

Harmonic Summary data returned from the 933A can be a strong indicator of what harmonics are being returned to the distribution system location by users with nonlinear loads. Harmonic content is potentially damaging both to the power company and the user. Without adequate protection, equipment will experience early failure and reduced overall efficiency.

A.8 KYZ (Pulse Metering)

KYZ Pulse Metering is a method of measuring energy usage by mechanical contact closures and openings at the meter. Each opening and each closure are separately counted as one energy unit, which unit is normally assigned by the utility provider. KYZ pulse metering is normally counted at the end of a line connected to the meter.

A.9 Kp Register Scale Factors

Kp register scale factors are used to scale the weighting of pulses in KYZ pulse metering. For more information on scale factors, see Section 7.5.3.
A.10 Linking

Establishing communications between the Model 933A and a computer device. Normally, this is done using PSCSV software.

A.11 RMS K

RMS K is the rms sum of all of the harmonic energy, including the fundamental (i.e. $1 - 50$), with each harmonic multiplied by the square of the harmonic number. It has the same units as the signal, i.e. volts or amps. For a clean signal, it will be almost exactly equal to the fundamental value. RMS K is calculated from the following equation.

\[
RMS(K) = \sqrt{(V_1 \times 1)^2 + \cdots + (V_{50} \times 50)^2}
\]

where $V_1$ is the fundamental voltage and includes all the harmonics up to the 50th.

A.12 RMS THD

The RMS Total Harmonic Distortion, or THD, is the rms value of all of the harmonics 2 - 50 and has the same units, volts or amps. RMS THD is calculated from the following equation:

\[
RMS THD = \sqrt{V_2^2 + \cdots + V_{50}^2}
\]

where $V_n$ is the harmonic rms voltage, and $n$ equals harmonic number.

A.13 TFTP

Trivial File Transfer Protocol (TFTP) is an Internet software utility for transferring files that is simpler to use than the File Transfer Protocol (FTP) but less capable. It is used where user authentication and directory visibility are not required. TFTP uses the User Datagram Protocol (UDP) rather than the Transmission Control Protocol (TCP). TFTP is described formally in RFC (Request for Comments) 1350.
A.14 THD F

THD F is the Total Harmonic Distortion compared to the fundamental and expressed as a percentage. THD F is calculated from the following equation.

\[
THD(F) = \frac{\sqrt{V_2^2 + \cdots + V_{50}^2}}{V_1} \times 100\%
\]

where \(V_1\) is fundamental voltage, and \(V_{50}\) is the highest measured harmonic.

A.15 THD T

THD T is the Total Harmonic Distortion voltage compared to the total voltage (fundamental plus harmonics) and expressed as a percent. THD T is calculated from the following equation.

\[
THD(T) = \frac{\sqrt{V_2^2 + \cdots + V_{50}^2}}{\sqrt{V_1^2 + \cdots + V_{50}^2}} \times 100\%
\]

where the denominator now includes the sum of rms harmonic voltages plus the fundamental.
Appendix B

Uploading New Firmware

The Model 933A Portable Power Sentinel allows you to upload new firmware via the RS-232 port from a connected computer with a serial port. If your computer does not have a serial port, then you can use a USB-to-Serial adapter to connect between the cable/adapter assembly that comes with the 933A and the computer.

B.1 Obtaining the Latest Firmware

Download the latest firmware version and 933uploader_vXXXX.exe program from the Arbiter Systems web site. The web address is listed below.

http://www.arbiter.com/pscsv/933index.php

The firmware will be in zipped format and does not need to be unzipped to use. The uploader program automatically extracts the file before uploading it to the 933A.

IMPORTANT! Do not halt the progress of uploading the new file into the 933A or it may not be recoverable. Especially, do not turn off the power to the 933A when the upload is in progress. If the upload stops for any reason, do not turn off power to the 933A. Try to restart uploading the file again.
B.2 Uploading Procedure

1. Connect the cable(s) and adapters between the computer and the 933A RS-232 port.

2. Start the uploader software, 933Uploader.exe. It should appear as shown in Figure B.1.

3. Check the communication settings on the Model 933A. Press the DISPLAY key, then 9-Config & Status. Under the heading COMMUNICATION, make sure you verify the baud rate.

4. On the 933A Flash Update Application (933uploader.exe), select Settings > Serial Port and select the correct port.

5. Select Settings > Upload Mode > RS-232 Serial Port.

6. Select Settings > Baud Rate > (select the same baud rate as the 933A discovered in step 3).

Figure B.1: Starting the 933A Uploader
7. Click the Open button or select File > Open. Browse to locate the zipped firmware that you downloaded, select the file and click Open. The uploader should automatically extract the zipped file ready for upload to the 933A. The uploader window should appear as in Figure B.2 and provide the firmware information.

![Figure B.2: File Information for Newly Extracted Firmware](image)

8. Click the Upload button (blue with a white UP arrow) and the file will transfer to the 933A. The uploader will start by erasing flash in the 933A, and indicated by the progress screen. After flash has been erased, the program should indicate the progress of the upload with a progress bar as seen in Figure B.3.

![Figure B.3: Uploader Progress Window](image)
At the completion of a successful upload, the uploader application will indicate the time that the firmware update was completed and that it was successful as indicated in Figure B.4.

Figure B.4: Successfully Uploaded File Information

9. You can close the uploader program.

10. The 933A should be ready to use, and not need to have power cycled.

If you should have any questions about uploading new firmware to the Model 933A, contact the Arbiter Systems technical support at the information listed on page ii.
Appendix C

CE Mark Certification

C.1 Introduction

The following page contains the individual CE Mark Certifications for the model covered in this manual. This includes Model 933A.
Declaration of Conformity with European Union Directives

Date of Issue: March 27, 2008

Directives: 89/336/EEC Electromagnetic Compatibility
73/23/EEC Low Voltage Safety

Model Number(s): 933A Portable Power Sentinel

Manufacturer: Arbiter Systems, Inc.
1324 Vendels Circle, Suite 121
Paso Robles, CA 93446 − USA

Harmonized EN55011 Class A, Radiated and Conducted Emissions
Standard EN50082-1 Generic Immunity, Part 1
Referenced: Residential, Commercial and Light Industrial environments
EN61010-1 Safety requirements of Electrical Equipment for Measurement, Control and Laboratory Use.

Signed: ____________________________

Signatory: Bruce H. Roeder

This certificate declares that the described equipment conforms to the applicable requirements of the directives on Electromagnetic Compatibility 89/339/EEC, Safety 73/23/EEC, and amendments by 93/68/EEC adopted by the European Union.
Index

933A Accessories
- 400 Amp direct CT, 8
- 811AT current lead set, 7
- 811CT current lead set, 7
- 813AT voltage lead set, 5
- 813BT voltage lead set, 5
- 816AT current lead set, 6
- 933A-02, 933A-03
  - low current modules, 9
  - adjustable bail, 8
  - auxiliary I/O module, 11
  - clamp-on CT, 9
  - GPS antenna module, 10
  - included, 2
933A Theory, see Functional Description

anticreep, 92, 93

Appendix
- A, 165
- B, 171
- C, 175

application software
  - PSCSV™, 30
  - AS007900X, current shunt, 7
  - Aux I/O port, 23

bandwidth, measurement, 37

battery
  - charging, 16
  - specifications, 133
  - status screen, 17
  - symbol, 16
  - type, 1

broadcast values
  - basic data, 95
  - energy data, 96
  - harmonic summary data, 98
  - harmonic values, 97
  - list, 101
  - phasor data, 100
  - waveform data, 99

button (PSCSV) definitions, 85

CE mark, 175
CE mark certifications, 175

clock
  - free running, 30, 38, 39
  - sync with GPS, 38
  - sync with IRIG-B, 38
  - synchronized mode, 40
  - UTC or Local, 40

clock (RTC), 29

clock accuracy
  - free running, 30
  - synchronized, 30

clock synchronization, description, 136

communication
  - Ethernet, 90
  - ports, 22
  - RS-232, 23
  - USB, 22

configuration, instrument, 62

configure
  - measurement parameters
    - from PSCSV, 92

connection
  - electrical system diagrams, 151
  - with PC, see linking

connection diagram
  - 3P4W3E using CT/PT, 163

connection diagrams
  - 1P2W15E direct, 153
  - 1P2W15E using CT/PT, 159
  - 1P2WIE direct, 152
  - 1P2WIE using CT/PT, 158
  - 1P3W2E direct, 154
  - 1P3W2E using CT/PT, 160
  - 3P3W2E delta direct, 155
  - 3P3W2E delta using CT/PT, 161
  - 3P4W25E direct, 156
  - 3P4W25E using CT/PT, 162
  - 3P4W3E direct, 157

connectors
  - Aux I/O, 23
power and energy, 138
PT and CT compensation, 139
serial channels, 147
signal sampling, 138
system time deviation, 144
transformer compensation, 140
triggering, 147
voltage and current, 139
voltage fluctuations, 144
voltage inputs, 130
fuse replacing, 23
type, 23
ground chassis, 19
harmonics broadcasting, 97
capability, 3
graphical, 52
measurement, 142
summary toolbar, 86
summary data, 98
tabular, 52
toolbar, 86
unwanted, 46
high-speed data capture, 116
HyperTerminal, see file transfer
IEC-320 power inlet, 1, 23
installing low-current modules, 47
interruptions, measuring, 143
IRIG-B timing, 30
issuance, ii
K Factor, 98, 109, 149, 167
keys, function
cursor & enter, 26
display, 24
display lighting, 26
hold, 28
log, 27
numeric keypad, 27
on/off, 24
print, 27
review, 27
setup, 25
soft, 25
Kp register scale factor, 121, 167
KYZ Aux I/O Module, 119
contacts, 121
pulse metering, 167
linking, 168
933A and PC, 81
load balance, description, 145
loss compensation (xfmr), 92
measurement basic data, 61
energy, 59
flicker, 58
harmonic, 52
min–max, 50
phasor, 60
power, 56
power quality, 57
sequence voltages and currents, 55
show impedance, 55
tabular results, 51
V I tabulation, 54
waveform, 53
Menus edit, 83
view, 84
menus Display Menus, 49
Setup Menus, 35
neutral synthesized, 20
numeric keypad, 26
operation ac power, 15
aux I/O signals, 23
basic, 15
battery, 16
battery charging, 16
battery indicator, 28
chassis ground, 19
communication signals, 22
connecting current signals, 20
connecting synchronizing signals, 21
connecting voltage signals, 20
data modes, 29
date and time, 29
display basic, 61
config and status, 62
energy, 59
harmonics, 52
min–max readings, 50
phasors, 60
power, 56
power quality, 57
voltage and current, 54
waveforms, 53
gps signal, 21
internal clock, 29
IRIG-B signals, 22
on/off, 24
replacing a fuse, 23
reviewing data, 65
power quality, 73
review rate, 69
searching, 71
using PSCSV, 74
setting triggers, 105
setup
autolog, 42
CT/PT, 44
current, 46
custom DST, 45
input, 36
internal clock, 38
low current modules, 47
RS-232, 41
tabular results, 51
triggers, 48
setup or configuration, 25
timing modes, 29
USB or RS-232, 30
using
display key, 26
function keys, 24
hold key, 28
log key, 27
numeric keys, 27
print key, 27
review key, 27
soft keys, 25
using PSCSV
configuring 933A, 89
linking to pc, 88
viewing modes, 29
oscillatory transients
detecting, 148
pausing a download, 86
phase balance, description, 144
phase measurement, 141
phasor data, 86, 90, 100
phasor measurement, description, 144
power calculation, 138
power input connector, 17, 23
Power Quality, see measurement
power quality, 106, 110
Powering the 933A
ac power cord, 15
battery, 16
PT compensation,
description, 139
Reviewing Data, 65
changing view rate, 69
data selections, 65
downloading, 75
erasing, 66
hold mode, 71
interpreting, 70
logged, 67
per–second data, 76
power quality, 73
searching, 71
selections, 69
waveform records, 78
RMS K, 168
RMS THD, 168
RS-232C, 23
safety information, 12
serial channels, description, 147
Setup key, 35
Setup Menus
autolog, 42
CT/PT, 44
current (range), 46
custom DST, 45
custom input, 37
input setup, 36
internal clock, 38
low current modules, 47
real-time clock, 38
RS-232, 41
triggers, 48
signal inputs, 20
signal sampling, description, 138
soft keys, 25
specifications
communications, 129
compensating constants
and ratios, 128
contacts, 130
dsp configuration, 129
environmental, 132
event inputs, 130
flash memory, 129
front panel, 128
input configurations, 127
input connector ratings, 128
input current, 128
input frequency range, 128
input voltage, 127
measurement, 131
  accuracy, 131
  phasor, 132
physical dimensions, 132
power requirements, 133
protocols, 129
synchronization
  GPS, 131
  IRIG-B, 130
system frequency, 130
system time, 130
timebase error, 131
VA, Watt, VAR, 128
status indicators, 28
  battery level, 28
data modes, 29
date and time, 29
timing modes, 29
viewing modes, 29
status, instrument, 62
stopping a download, 85
support
  request, iv
synchronized, 30
synchronizing, 21
  using gps, 21
  using IRIG-B, 22
synchrophasors, 37
system time deviation, 144

Tera Term Pro, see file transfer
TFTP, 168
THD F, 169
THD T, 169
time (system) deviation, 144
title page, v
Toolbar
  flash, 86
  Toolbars, 85
    broadcast, 85
    configure, 87
    connection, 85
    input, 86
    main, 85
records, 87
transformer compensation, 140
triggering, description, 147
Triggers
  definitions, power quality, 112
  definitions, user, 109
  dependency, 109
  erasing, 118
  example, waveform, 117
  high-speed data capture, 116
  hysteresis, 113
  logging time, 108
  power Quality, 106
  power quality, 110
  power quality reference, 113
  recording data, 105
  recording methods, 105
  relay settings, 121
  setting user, 106
  setting with PSCSV, 123
  sliding reference, 115
  user, 106
  user trig definitions, 107
  using Aux I/O Module, 119
  viewing, 1-sec., 118
  waveform capture, 116

Universal Test Plug Current Lead Sets, 7
USB, 3, 19, 22, 30
  connecting, 89
  description, 147
  downloading waveform, 75
  specifications, 129

version
  manual, v
Virtual COM Port (VCP), 22
voltage
  fluctuations, 144
  inputs, description, 136
  lead sets, 5
  measurement, 139

warranty, iii
waveform data, see Broadcast
  values